
A Fresh Newsgroup List

Each time News is collected, Turnpike also collects a list of any new newsgroups that have become 
available at the news server(s) selected, since you last collected News. These newsgroups are then 
added to the list of available newsgroups stored on your machine.

All this happens automatically, you don’t need to do anything.

If you start collecting your news from a different news server, ensure that you load a fresh list. This is 
because not all news servers carry the same range of newsgroups. You may wish to do this from time to 
time even if you do not change your news server.
 
To request a fresh list of newsgroups to be downloaded check the option to Update newsgroup list at 
next connection in the Configure News Server dialog. 

The next time News is collected, Turnpike will pick up a complete list of newsgroups. When this has been 
done this option will be unchecked. The list won’t be picked up again until you check the option again.

The complete list may take some time to download. 

Wait for the load to finish. If the list is not fully downloaded and filed, Turnpike will continue to try to 
download this list each time News is collected until it succeeds. Only then will the Update newsgroup list
option be cleared.

Related Topics
Configure News Server dialog 



Abandoning a Telnet output

If you want to stop any further output being sent to your machine, try pressing F4. This sends the Telnet 
'Abort output' command to the remote computer.

Some systems ignore this command.

Related Topics 
Introduction to telnet
keyboard layout.



Abandoning a Telnet command

If you've started an action at the remote computer by mistake and you don't know how to stop it, try 
pressing F3. This sends the Telnet 'Interrupt Process' command to the remote computer, which should 
have the desired effect - though some systems ignore this command.

Related Topics 
Introduction to telnet
keyboard layout.



Access Provider dialog

This dialog is called by selecting Service Access from the Configure menu.

This dialog is used to set which Access Provider you are currently using and the details of your access to 
the Internet using that Access Provider.

Connection The name of your Access Provider
Hostname See Host Configuration dialog
Login Password The password used when contacting your Access Provider
DNS Address 1 and 2 The Domain Name Servers you will be using

The information in this dialog is set from the 'script  '   installed for your Access Provider and from the 
answers you gave when your Access Provider was first recorded. This dialog enables you to confirm the 
settings made and when necessary to change them. If you are in any doubt about any setting, you 
should contact your Access Provider.

  It should not be necessary to change any of the information given in this dialog.

Alter
1. Click the Alter button, the Internet Access Provider dialog appears.
2. Click the down arrow and select the Access Provider you want to use.
3. Click OK.
4. Click OK again.

New
When you click this button, the Internet Access Provider dialog appears this time with a More button. 
You can use this dialog to reinstall your existing Access Provider e.g. the details of your account with 
this Access Provider have changed or to install a New Access Provider.

Click here if the Access Provider you want to use is not listed.

· To install a new Access Provider:
1. Click the New button on the Access Provider dialog.
2. Click the More button on the Internet Access Provider dialog.
3. Select one or more Access Providers from the Select Access Provider dialog.
4. Click the Continue button to return to the Internet Access Provider dialog.
5 Click the down arrow and select one of the new access providers you have added.
6. Click the OK button and work through the sequence of questions about your account. 
7 If you want to exit from these questions press the Esc key 

Related Topics
Going On-line
Installing a new access provider script



      
Adding new users
Before someone can sign-on and use Turnpike, they first need to be allocated their own 
'seat' on the system (principally so that their mail is correctly delivered to them). The 
person who installs Turnpike is automatically allocated seat number 001 and given the 
administrative power to allocate the other seats that are available on the system. New 
users are allocated to seats from the main Turnpike program.

For further information, read the section on Allocating users to seats in the Set-
Up book.



Address
The multipart name (such as turnpike.com or 
demon.co.uk) that gives the address of a 
computer on the Internet by identifying its position 
within the Internet's Domains structure.



Alert:    Incorrect entry
Correct what you typed, then try again.



Alert:    Invalid UK Post Code
Check the post code entered has the following form and is entered correctly:

· Start with either one or two letters, followed by one or two digits
· Then leave a space, followed by a single digit and two letters

If you don't know your postcode or you live abroad, click here.



Alert: Abandon Online Registration

If you really want to abandon Online Registration, click Yes.

If you want to review or change information you entered earlier, click No. You will then return to the first 
screen of this Online Registration Wizard, with the information you entered earlier all still there. You can 
then work through making any changes you need.



Alert: Credit Card Expiry Date
Only expiry dates from the current date to 10 years hence are accepted. Any other date entered is 
assumed to be an error.



Alert: Enter the Product Code
Enter the Product Code supplied with the CD from which you are installing.

This slot must not be empty. 



Alert: Phone Number Error
Phone numbers inside the UK should normally be given as a simple sequence of digits. You can include 
spaces, hyphens and parentheses if you wish. Do not use spaces in extension numbers.

Numbers outside the UK should be given in the standard 'International' form of a + then the country code, 
followed by the appropriate number.

Check that number entered is correct.



      
Alert: Phone number too short
To check the number, click the No button and make the 
necessary correction. 

If you are sure the number is correct, click the Yes button
and proceed.

For further help refer to Connection Settings 



Alert: Set Logon Password

You must set a logon password, made up of at least 6 ASCII characters (no spaces).

Click here for advice on choosing a good password.



      
Anonymous FTP
This is a system whereby you can copy files from 
the public areas of certain computers' disks.

To access a computer's public area, you need to 
FTP to that computer, log-in as 'Anonymous' and 
give your email address as the password.



Archie

Archie is a system that enables you to search through indexes of the files available through Anonymous 
FTP. These indexes are amended month by month - and sometimes more frequently.

You give Archie either the main name of the item you are searching for or a word that's likely to be in the 
file's description. Archie then responds with a list of entries containing this main name, from which you 
then note the details of the file you want.

The main way to access Archie from Turnpike is to:
* Telnet to a suitable (public) Archie client and log in as 'archie'.

The commands to give to find the information you want then depend on the Archie client you've selected. 
The initial 'Welcome' screen may contain instructions. If not, you may be able to see a list of the 
commands supported by this Archie client by typing help [Return].

If you have WS_Archie v0.5 (the version supplied with DISWIN), you will need to upgrade this to the latest
version to run it alongside Turnpike. You can download the new version by FTP from: 

ftp://ftp.demon.co.uk/pub/mirrors/simtel/win3/winsock/wsarchxx.zip



Article Requests

When discussion threads are expanded, they frequently include entries shown only as . These 
represent articles that form part of the discussion thread but aren't included in the current newsbase.

Similarly, where you've opted just to 'browse' a particular newsgroup, you will find the entries in the 
discussion threads marked  or 

 to show that just the header of the article has been downloaded.

If you want to read either a missing article or one you currently only have the header of, you can ask for it 
to be downloaded the next time you go on-line - see Requesting a missing articles in Turnpike Help.

 
You cannot change the list of article requests while news is being collected.

· To cancel requested articles
If you change your mind about requesting an article, you are able to cancel requests one at a time in the 
Turnpike program.

If a large number of articles have been requested you are able to cancel all or some in Connect.

1. Select News Collection from the Configure menu
2. Click the Requests button in the Configure Usenet News dialog to display the Edit Requested 

Articles list dialog.
3. Select either the System, User, or All options
4. Click the down arrow and select a News Server from the list or accept the All Servers option. The 

requested articles will be listed in the main window
6. Use Shift click and Ctrl click to select the articles you want to remove
7. Click the Remove button.

To cancel all requests, click the Remove all button.
To reinstate all requests, click the Restore all button.

 
Only those articles listed in this dialog will be removed or reinstated.

When requested articles are cancelled they are marked . To request an article just click on the 
symbol as before. An attempt will then be made to retrieve the article the next time you go on-line.

Related Topics
Browsing a Newsgroup



      
'Are you there?'
Select this option to check that the remote computer 
you've logged into is responding.

If you don’t get a reply it won't necessarily mean that 
the computer has 'died' as not all computers answer this
question.

Quick keystroke: F2



Backing up your Turnpike files

As in any program, it is good practice to keep back-up copies of the following files:

From the Turnpike directory TURNPIKE.USR
CALLS.TPK
The .INI files
Any .ACC file that has been modified
Any .MDM file that has been modified

From the Mail directory MSPOOL
MAILBASE
ADDRBOOK

From the News directory NSPOOL
NEWSBASE

plus 

the whole of each user's directory (these have names of the form USERxxx).

Other files don't need to be backed-up because they can, if necessary, be recovered either by reinstalling 
Turnpike or, in the case of the additional files in the News directory, by re-building the Newsbase.

Related Topics
Rebuilding the Mailbase etc
Merging databases
Moving Turnpike to another machine or system
File paths dialog



Bind error, address in use
If Connect crashes whilst you are online, you may find that the next time you connect you see 
the message "Bind error. Winsock ERROR: address already in use" and no email is delivered 
to you.

This usually occurs because previously Connect did not shut down cleanly and was therefore 
unable to inform the Winsock that it was no longer 'listening' for email. When you next start 
Connect, the Winsock thinks that an email server is already running and declines to start up 
another. Of course, if you are actually running another Email server, you should shut it down, 
as only one such device can be used at a time.

The fix is simply to restart Windows. This launches the winsock afresh, with no memory of 
previous listeners, and everything will work fine.



Browsing a Newsgroup
To browse a newsgroup is to download just the header of each 
article. This saves a considerable amount of disk space while 
still allowing you to see whether there is anything of interest to 
you. If you want to browse a newsgroup, in the Newsgroup 
Subscriptions dialog set the Type of the newsgroup to 
Browse.



COM ports

Most PCs are supplied with two COM or Serial ports, referred to internally as 'Com1', 'Com2' etc. You may
have more. Typically one of these ports will have your mouse attached to it. Each port is associated with 
an IRQ and an I/O Address. Confirm your setup as follows:-

1. From the Windows 95 Start menu select Control Panel.
2. Double-click on System.
3. Select Device Manager.

Examine the properties of the COM ports listed and amend settings as required for your modem. 
Information may be given in the books supplied with your PC and any plug-in cards you've added.

· You can plug your modem into any free serial port
If you just have the standard two ports with your mouse fitted into one of them, plug your modem into 
the other port. Now identify which port is 'Com1' and which is 'Com2'. Look on the connectors on your
PC they may be marked, if not then try each connector in turn until you are able to access your 
modem.

· If you have fitted a 16550 (or similar) serial card
Plug your modem into the serial port supplied on that card. This port will typically have been 
configured as Com3. You may need to connect your mouse to Com2.

If your PC has an internal modem ensure that there is no IRQ conflict with the mouse.

If your PC has a Com4, avoid connecting your modem to this port as it may cause interference with 
your video card.

    If you are still in doubt, consult your hardware supplier.

Related Topics
Which modem to pick
Installing your modem



Call Costs Tariff file example

[Title]
ident=Friendly Phone Company

[Data]
ValidFrom=10/6/97
Days=1,2,3,4,5
ConCharge=200
MinCharge=455
Band=0;100
Band=28800;350;t * (((1 - min(1, s)) * 60) + (max(e, 60) - max(s, 60)))
Band=64800;100
CostFunction=t * (((1 - min(1, s)) * 30) + (max(e, 30) - max(s, 30)))

[Data]
ValidFrom=10/6/97
Days=6,7
Also=25/12,26/12
Moveable=GdFri,EMon,MayD,MBnk,ABnk

Band=0;90

Related Topics
Call costs: Tariff file format
Call costs:Tariff file calculations 
Call costs



Call Costs: Colour Selection dialog

This dialog is called by selecting the Colour option from the Call costs Options menu. The dialog 
enables you to select the colour used for text and background in the call cost displays.

The Colour selection dialog offers both a palette of colours from which to pick and, on the right, a 
complete colour spectrum from which to select a 'custom' colour. If you want, you can add the colours you
select from the colour spectrum to an additional palette of Custom colours.

To select a Custom Colour
1. Click on the colour you want in the spectrum.
2. Click on the sample bar to the right of the spectrum to set the colour luminosity. This is the amount of 

white/black you want in the colour.
3. Click the Add to Custom Colors button to add this custom colour to the Custom palette.

To replace an existing colour in the Custom palette, select the entry in the Custom palette before setting 
up the new colour. The 'old' colour will be replaced by the new one when you click the Add to Custom 
Colors button.

· To set or change a Call cost colour
1. Click Options.
2. Click Colour, the Colour selection dialog is displayed.
3. Click the down arrow in the selection box at the bottom of the dialog to select the text or 

background item you want to change. The current colour is shown in the Colour Solid box.
4. Select the new colour you want to use from the pallete or use a custom colour.
5. Confirm the colour you want is shown in the Colour Solid box.
6. Click OK to confirm.

ColourSolid box.
Text is only ever displayed using the 'Solid' part of the colour you select. So when setting the colour 
for text, be sure to check the 'Solid' part of the sample shown in the dialog because this is what will 
be used.

Related Topics
Call costs: Options menu
Call costs: Font



      
Call Costs Options menu: Font
Displays a Font dialog from which you can select the typeface 
and type size (and type style) used to display commands and 
responses on the call costs screen.

    This option only sets the font used for the call costs 
display. The font used when printing is set through the Print 
font option in the File menu.



Call costs

Turnpike automatically logs the time, duration, destination and cost of calls made by each user of 
Connect.

Turnpike enables you to subtotal these records either on a regular basis, or at dates to correspond with 
your phone bill. You are able to keep detailed records for ever, choose to discard old records or 
amalgamate them into summaries. You are also able to print records and export them, for example to a 
spreadsheet program.

· To access your record of calls and the various configuration options:-
select Call costs from the Function menu;
or, click the Call costs button on the toolbar.

The main log screen opens showing a detailed view of the log. You can sort this log in a number of ways. 
You are also able to highlight records in the log to get an instant analysis of time and cost for a particular 
group of calls.

Turnpike estimates the cost of calls by applying information about telephone tariffs. The available tariffs 
include those for a number of phone companies and include standard discount packages such as BTs 
Friends and Family and Premier Line.

It is not essential to set the correct tariff before logging begins. Providing detailed records have not been 
deleted, you are able to apply a different tariff to all or part of the log at any time. You are also able to 
apply what if scenarios by changing the phone tariff and inspecting the new totals.

The logging system applies the correct rate for the time and day of the week. Even if a call spans more 
than one charge band It takes account of any minimum charge for each call.

The logging system does not include the VAT payable on telephone charges.

Turnpike are not experts on telephone tariffs. You are advised to use the information provided only 
as a general guide for your actual telephone bill. You should check that the calculations made are 
accurate enough for your needs. The precise moments at which calls are connected and terminated 
are not reported by modems, so Turnpike's records can differ slightly from the times logged by your 
telephone company.

The information in the tariff files has been compiled from public sources. They may not be complete, 
errors may have been made in transcription, the original data may have been incorrect or may now 
have been superseded. The tariffs used may not be applicable to your circumstances.

Only users who have Connect admin permission can view the entire log and make changes to it.

Other users will only see a record of their own calls. Although they can make changes to this on 
screen, any alterations made, including importing a modified log will not be permanently recorded.

Related Topics
Call costs Menus





      
Call costs: Options menu: Colour
Displays a Colour Selection dialog from which you
can select the colours used to display call cost 
text on your screen.



Call costs: export example

day 10
month 6
year 1997
hour 9
minute 6
second 0
phone 01234 123456
duration 1 hour 23 minutes 10 seconds - 4990
cost 279.44 pence
carrier BT - Basic Rate
user seat number of wombat - 3
state completed
summary? No - so blank

Since it is not a summary record all other fields after state are blank and can be left out.

The record (with actual carriage returns marked CRLF) looks like this:

10, 6, 1997, 9, 6, 0, 01234 123456, 4990, 279, BT - Basic Rate, 3, completed CRLF

Related Topics
File menu: Export
Call costs
Call costs Menus



      
Call costs: Change Carrier
This option enables you to select a different carrier to 
associate with the existing selected record(s). You might 
wish to use this option to change the carrier set when you 
configured your Call costs.

 You will need Connect admin permission, to make a 
permanent change to the records.



Call Costs File menu: Close
Exits from Call costs.



Call costs: Configure Carriers

The Associated carriers and connection dialog displays the telephone carrier associated with each 
connection you have setup. This association determines the tariff Turnpike will use to cost your calls.

· To change an association
Select the connection and click Alter Carrier
Or, to change all connections to the same carrier, click Alter All.
Choose your new carrier from the list.

 If the carrier you want is not listed, click the More button to see a complete list of tariffs available 
for various carriers.

If you choose to associate a connection with the (free) option, only time on-line will be logged, not 
costs.

You are also able to change carriers from the Edit menu.

Related Topics
Call costs: Tariff file format
Call costs
Configuring Call costs



Call costs: Configure Delay 

This option calls the Configure Connection delay dialog. This dialog enables you to set the time in 
seconds between the start of dialling and the point at which the remote machine answers the call. This 
may help to avoid logging a cost for calls that do not connect e.g. number engaged.

This setting is ignored if you connect through a third-party dialler and winsock. There may be a delay 
between the time when the call is connected and when you click the Connect now button (which is 
when logging will begin). You can allow for this delay by adding an appropriate number of seconds in 
the box in the lower part of the dialog.

The phone number(s) you dial will be recorded as other dialler if you do not dial in through Connect.

 Only users who have Connect admin permission can make permanent changes to the 
configuration settings or to the actual Call cost records.

Related Topics 
Call costs
Call costs Menus
Configuring Call costs
Call costs: Configure menu



Call costs: Expiry

This option calls the Expiry of call records to create summaries dialog. Use this dialog to avoid 
keeping more detail than you need.

Turnpike can expire Call cost records. When expired, details of individual calls will no longer be available. 
Turnpike will maintain a summary of calls by Date, User, Carrier and Telephone number.

The choices for expiry are:
· Manually created summaries only i.e. no expiry of detailed records.
· Automatically summarises records.

If you choose automatic summaries, options enable you set how many individual records, days or 
months Turnpike should keep in full. After this number has been reached, full details will no longer be
available and will be automatically replaced by summaries.

· When you open the Call costs window, Turnpike will expire the records, 

· If you choose Automatically summarise records, Turnpike will immediately replace detailed records 
with summaries for all records that have expired, according to the criteria you have set. If you do 
this by mistake, you can abandon the process by selecting Revert from the Edit menu at any time 
until you close the Call costs window.

· To compare detailed Call cost records with your telephone bill, ensure that any expiry set covers 
the billing period

 Only users who have Connect admin permission can make permanent changes to the 
configuration settings or to the actual Call cost records.

Related Topics 
Call costs
Call costs Menus
Configuring Call costs
Call costs: Configure menu



Call costs: Subtotals

This option calls the Configure subtotals dialog. Use this dialog to set how subtotals are displayed in the
Call costs log.

When you have configured Call Costs to display subtotals, these will be displayed highlighted by a 
coloured bar, when viewing the log in Detail mode.

The choices are
· No automatic subtotals
· Monthly subtotals
· Subtotal at billing dates, as shown on your telephone bill

· Subtotal at billing dates
1. Enter the dates in the New billing date fields.
2. Click the Add button to apply.

 You will receive a warning if you attempt to duplicate a date already listed.

· To delete a billing date
1. Select the date in the right hand box
2. Click the Delete button

 Previous billing dates for which details have been summarised are shown greyed out. These dates will
be automatically deleted when you delete the associated summary records.

You are able to change the date to generate new subtotals at any time until you convert them to 
summaries. This will freeze your records. Subtotal dates prior to the summary date cannot be deleted or 
added.

 Only users who have Connect admin permission can make permanent changes to the configuration 
settings or to the actual Call cost records.

Related Topics 
Call costs
Call costs Menus
Configuring Call costs
Call costs: Configure menu



Call costs: Configure menu

Carriers
Subtotals
Expiry
Delay.

 
Only users who have Connect admin permission can make permanent changes to the configuration 
settings or to the actual Call cost records.

Related Topics
Call costs
Call costs Menus
Configure Call Costs



      
Call costs: Copy
Copies the currently selected 
record(s) to the clipboard.



Call Costs Options menu: Date format

This dialog enables you to select the way dates and times are shown in the Call record log.

You are able to set:
· The Display order for Date, Day and Time.
· The Date order for Day, Month and    for Day, Month and Year.

Check boxes enable you to set whether or not to show Time, show Day, Months as text and to use a 24-
hour clock.

The example slot at the bottom of the dialog will show the effect of any changes you make.
 
Related Topics 
Call Costs: Options menu
Call Costs



      
Call costs: Delete
Deletes the selected record(s).

 You will need Connect admin permission, to make a 
permanent change to the records.

 Once deleted, the records will be lost. However, providing you 
haven't closed the Call costs window, you can change your 
mind by selecting Revert from the Edit menu.



      
Call costs: Delete before
Deletes all call records before the selected date and 
time.

 You will need Connect admin permission, to make a 
permanent change to the records.

Once deleted, the records will be lost. However, 
providing you haven't closed the Call costs window, you 
can change your mind by selecting Revert from the Edit 
menu.



Call Costs: Detailed Log

This is screen is displayed when you select Call Costs  from the main connect display.

The log comprises individual call records, with separate columns for:

State Date & time Phone number Duration Cost User Carrier

· To change the width of the columns
Drag the vertical bars between each of the column headings.

· To scroll through the records
Use the arrow keys and the mouse. Use PgUp and PgDn to move a screen full at a time. Use the 
End key to go to the last entry and Home to go to the first entry in the list.

· To change the sort order 
Either 

Select Sort from the Call cost menu bar
Select the sort order you want to use

Or
Click a column heading.

· A second click on the same heading    will reverse the sort order.
· When you sort by User, each user's records will appear in chronological order.
· Time and Date are separate commands.
· When you sort by Time, records are listed in duration order.
· When records are sorted by any category other than Date or time, the Date & time fields are used

as a secondary key.
· The phone number will be recorded as 'other dialler' if you do not dial in through Connect.
· The status bar shows whether you are viewing the log in Detail or in Summary. To change the 

view, click the adjacent down arrow and select from the list.

· Instant analysis
For any group of selected records, the status bar shows the total time and cost of calls. Use shift click
and cntrl click to select the records you want used.

You may find it easier to make your selection if you change the sort order of the log first. For example,
to analyse the cost of just your longest calls click on the Duration heading before making your 
selection. 

· Subtotals
If you have configured Call Costs to automatically display subtotals, these will be displayed, 
highlighted by a coloured bar, when viewing the log in Detail mode.

Related Topics 
The log in Summary mode.
Call costs
Call costs Menus





Call costs: Edit menu

Revert

Copy

Select all
Invert selection

Summarize before
Delete
Delete before
Change carrier

Related Topics
Call costs
Call costs Menus



Call costs File menu: Export

This option enables you to export your complete log of call costs as a Comma Separated Value(CSV) 
data file.

When you select this option a file selector is displayed asking you where you want to save the file. You 
save the log as a .txt file. This can then be used typically to create a spreadsheet. The comma delimiting 
character will define the columns. Each record will be a row.

A typical .txt file is shown above. Entries are arranged one to a line.

An entry may be either,
· an ordinary record representing a single call; as shown above;
· or a summary record representing a number of calls made over a period of time.

A description of each item of information, separated by commas is given below.

· Details of each entry
Date of start of call (in an ordinary record) or the end of the range of dates covered (in a summary
record).
· 1 ... 31
· month1 ... 12
· year 1970 ... 2099

Time of start of call (in an ordinary record).
· hour 0 ... 23
· minute 0 ... 59
· second 0 ... 59

Phone number as given in the Phone number column
Duration of call seconds
Cost of call pence (left blank if unknown)
Carrier as given in the Carrier column
User the Turnpike seat number of the user who made the call.

Last recorded state of the call 
· Ok, dialed
· Or, incomplete
· Or, no charge. This is in an ordinary record only. Blank for summary records

Whether this record is a summary record (written summary) or left blank.

Start of range dates for a summary record (left blank for ordinary records).
· 1 ... 31
· month1 ... 12
· year 1970 ... 2099

Whether the recorded cost is, 



an exact total, (written exact) 
or a minimum, (written minimum), for summary records only, left blank for ordinary records.

Any further fields on a line are ignored. The space before or after any entry is ignored.

Where any of these items is blank, the comma that separates it from the next piece of information 
must still appear. This will ensure that the remaining pieces of information are associated with the 
correct parts of the Call record. If the remaining entries are themselves all blank, the record can be 
finished with a carriage return: Turnpike will then automatically make the remaining items of the 
record blank.

Related Topics
Detailed example of an export file
Call costs
Call costs Menus



Call costs: File menu

Save changes
Import
Export.
Close

The following items are common to the main Connect File menu
Print
Print Preview
Print Setup...
Print Font

Related Topics 
Call costs 
Call costs Menus



Call Costs File menu: Import
Enables you to import suitably formatted data into your 
call cost log. See export. for details of the CSV format 
used.

    If you do not have Connect admin permission, 
using this option will not make a permanent change to 
the records.



Call Costs: Invert Selection
Deselects the current selection of records, 
and instead, selects those that were not 
previously selected.



Call costs: Menus

When you launch Call costs, you will see the Log screen and the following items on the menu bar:

File
Edit
Configure
Sorting
Options
Window
Help

Click the right mouse button while in the Call costs window to select available menu options.

Related Topics 
Call costs



Call costs: Options menu

The Options menu enables you to set how your PC displays information for the following:

Font
Colour
Date format

Related Topics
Call costs
Call costs Menus



Call Costs Reverse the sort order
If the current order is low to high (0...9 or A...Z) the
list will be re-ordered as high to low, and vice-
versa.



Call costs: Revert
Abandons any changes you have 
made in the current session, and any 
expiry done at the start of the 
session.



Call Costs File menu: Save 
changes
Saves any changes you make to your Call 
costs.configuration.



Call Costs: Select All
Selects all call records.



Call costs: Sorting

This menu enables you to sort the Call costs log by date, time, user, phone number, cost, carrier, duration
of call or state. A further option enables you to reverse the sort order.

You can also change the sort order by clicking on the relevant column heading in the log itself. A second 
click on the same heading will reverse the primary sort order.

Related Topics 
Call costs
Call costs Menus



State

The state of a call may be recorded as:

OK The call was successfully dialed, connected 
and terminated.

no charge No call charged for (e.g. the number was 
engaged or unobtainable).

dialed The call was initiated, but it was not known if 
any connection was successfully made.

incomplete The call was connected, but Turnpike was 
unable to recognise a normal termination of 
the call.



      
Call costs: Summarise before
Converts call records up to and including the selected date, 
from detailed to summary form.

 You will need Connect admin permission, to make a 
permanent change to the records.

Once converted, the detailed records will be lost. If you want 
to abandon the conversion, and you haven’t closed the Call 
costs window, select Revert from the Edit menu.



Call Costs: Summary Log

The summary view of the Call Cost Log Screen condenses the database of individual call records into 
totals for each user, carrier and telephone number.

If Call Costs has been configured for automatic subtotalling separate summaries are displayed for the 
periods you have defined.

The status bar shows whether you are viewing the log in Detail or in Summary view. To change the view,
click the adjacent down arrow and select from the list.

Related Topics 
The log in Detail view
Call costs
Call costs Menus



Call costs: Tariff File format

The pricing information for a carrier is held in a tariff file (with a .CST extension) in the \turnpike directory. 
This is a text file in the format described below. 

Tariff files are packed together in the tariff.tpk file and are extracted, as needed using the Alter carrier 
dialogue.

Turnpike provides tariff files for a range of telephone services.

You should not normally need to write your own .CST file. If you do find that you need to write your own 
tariff file, look at the existing tariff files first. These will provide a template you can use in conjunction with 
the information given below.

A tariff file consists of a [Title] section followed by one or more [Data] sections.

· The [Title] section
contains an entry giving the name of the carrier and charging scheme, e.g. Ident=BT Friends & 
Family.

· Each [Data] section
contains the information required to determine the cost of any part of a call after a given date and on 
given days of the week.

A [Data] section must contain an entry giving the date on which the section becomes valid e.g. 
ValidFrom=10/6/1997, and an entry giving the days of the week on which the section applies
Days=1,2,3,4,5.        where 1 = Monday, 2 = Tuesday, etc.

A [Data] section may also contain an entry giving additional dates (such as fixed public holidays) on 
which the section applies regardless of the day of the week. For example, the following line indicates 
that a section is valid on Christmas day and boxing day.
Also=25/12,26/12 

There may also be an entry to specify any moveable public holidays for which the section applies, e.g.
Moveable=GdFri,EMon,MayD

The recognized holidays are:
GdFri Good Friday
EMon Easter Monday
Ascn Ascension
WtMon Whit Monday
MayD May Day
MBnk May bank holiday (UK)
ABnk August bank holiday (UK, except Scotland)
SABnk August bank holiday (Scotland)

There may be entries giving a minimum call charge and a per-call connection charge, in 1/100ths of 
a penny. e.g.

MinCharge=300
ConCharge=150

Each day for which the [Data] section is valid is partitioned into time bands during which different 
tariffs apply. For each time band there should be an entry in the [Data] section giving the start time of
the band in seconds since 00:00 and the tariff for the band in 1/100ths of a penny per minute, e.g. 



Band=26600;100

A time band is assumed to end when the next band begins, or at the end of the day in the case of 
the final band.

You can allow for planned changes by having two or more DATA sections for one charge band, for 
example
Current charges (ValidFrom=1/1/1998)
Future changes (ValidFrom=1/4/1998)
The system will process these in date order. The order in which they are listed makes no difference 
but for clarity you are advised to list them in date order.

Related Topics 
Typical tariff file.

Call costs:Tariff file calculations 
Call costs



Call costs: Configure subtotals dialog: duplicate date
You cannot enter a date which is already in the list or which is before the date at which your detailed call 
records currently begin.



Calling up information by Telnet

1. Connect to your Access Provider.
2. Click the Telnet button.
3. Enter the address for the computer / service you want in the Telnet to slot of the dialog.
4. Set any special port that's required in the Port box of this dialog. If no port is specified, leave this set 

to Telnet.
5. Click the Connect button.

Turnpike will contact the computer/service you have selected, and negotiates which terminal emulation to 
use.

If one of the DEC emulation's is selected (VT52, VT100 etc.), Turnpike will also set the numeric keypad 
area of your keyboard to mimic the keypad on a DEC keyboard: see DEC / PC layouts.

The remote computer / service will then ask for a login name and, if appropriate, a password. The details 
to give here should be clear either from the information displayed by the service itself or from the listing of
Internet services from which you found out about this service.

The application will now run at the remote computer. Read its sign-on message to determine how to call 
up instructions on how to use the service you've logged onto. If any of this information has already 
scrolled off the screen, press F9 to switch the screen into 'Session review' mode. You will then be able to 
scroll back over everything that has been displayed. Press F9 again to continue. If no such instructions 
are given, try typing ? [Return].

To finish the session, do whatever the application tells you to 'quit' the service you've called up and then 
select the Close option from the File menu.

When you want to telnet to a site you have visited before, pull down the list of addresses from the Telnet 
to slot of the dialog and select the address you want. Turnpike remembers previous addresses that you 
have used.

Related Topics
Telnet keyboard options
Logging the Telnet session
Taking a snapshot of the screen
Terminal emulation
DEC / PC layouts



Changing subscription information

When first subscribing to a newsgroup, Turnpike is initially set to:
· Download articles from this newsgroup to your disk in full
· Expire these articles from your disk after 3 days

Anyone with News Admin permission is able to change either of these details.

You are able to choose to download just the article headers. 
You are also able to choose to have the articles from the newsgroup automatically marked 'to be kept'. 
These articles will then only be removed from your disk after you have cancelled the 'Keep' marker on the
article.

      These changes are made in the main Turnpike program.



Collecting News

If there are any new articles that have been submitted to the newsgroups that you subscribe to when you 
go on-line, you will probably want to have these copied to your system. By default, this will happen as 
soon as you click the Connect button on the Connect to Internet dialog.

If you have Connect Admin permission, you are able to change the default.

· To have new articles downloaded automatically 
1. Click Configure
2. Select News collection - the Configure Usenet News dialog appears
3. Check the Automatic collection option.

· To keep this action under your control
1. Click Configure
2. Select News collection - the Configure Usenet News dialog dialog appears
3. Leave the Automatic collection option clear

To collect news click the Start button in the News collection area of the display. To see what is 
being downloaded, click Window in the menu and then select the News Client.

The number of articles to be downloaded won't necessarily match the number of new articles that 
appear to be read in your newsgroups.

If you want to see what is being downloaded click Window in the menu and then click News 
Client.

If you close the main connect window while active the download will stop; however you may 
minimise it.

Stay connected to your Access Provider at least until the message News collection closed - 
filing continues appears.

Stay in the Connect program until the message News completed, xxxx articles fetched and filed
message appears. If you do not stay in the connect program the list won't be filed correctly and will 
have to be collected again the next time you connect to your Access Provider.

There’s no need to wait for all news to be filed before you click the Disconnect button. However 
you must wait for filing to be complete before you exit the Connect program.

When all the mail and news has been collected and you have completed any other on-line actions 
click on the Disconnect button.

Related Topics
Configure Usenet News dialog
Mail and News Service Indications



Collecting the list of newsgroups

Before you can subscribe to any of the Usenet newsgroups, you must collect a list of the newsgroups 
available from your Access Provider's news server.

Turnpike automatically collects this list the first time you use Turnpike to connect to your Access Provider. 
After that, any new newsgroups that become available at the news server are automatically added to your
original list. Although the amended list will work, it is a good idea to collect a fresh copy of the list every so
often.

· To arrange for a fresh list to be downloaded the next time you collect news
1. Click Configure;
2. Select News collection option - the Configure Newsnet News dialog appears;
3. Check the Update newsgroup list at next connection option.

Although there are over 20000 newsgroups, it should be possible to collect the complete list in 
approximately 5 minutes. This may take longer if it is a particularly busy time. If it takes much longer than 
5 minutes, check your machine setup.

Whatever is making collection of the list slow is likely to affect every transfer of information you make in 
the future. Let Turnpike finish collecting the list before taking any action.

· Stay connected to your Access Provider until the message News collection closed - filing 
continues appears.

· Stay in the Connect program until the message News completed, xxxx articles fetched and filed 
message appears. If you do not stay in the connect program the list won't be filed correctly and will 
have to be collected again the next time you connect to your Access Provider.

Related Topics
Enhancing the speed of collection
Updating the list of newsgroups
Browsing a newsgroup



Commands menu (in Telnet)

This menu enables you to select commands for the following standard facilities. Note that some of these 
commands are actually transmitted to the remote computer. Any action taken will depend on the remote 
computer.

Are you there?
Interrupt Process
Abort Output
Erase Line



Commands menu: Abort Output
This command option is the Telnet command for abandoning 
any further output from the current action.
Note: Response will depend on the remote computer you are 
connected to.
Quick keystroke: F4



      
Commands menu: Are you there?
Allows you to check whether the remote computer you are 
logged into is still responding. However, the lack of a reply 
won't necessarily mean that the computer has 'died' as not all 
computers answer this question.
Quick keystroke: F2



      
Commands menu: Erase Line
Deletes the current command line (where commands are being
sent line-by-line).
Quick keystroke: Ctrl + <



      
Commands menu: Interrupt Process
Sends the Telnet command for halting the current action.

Response to this command is dependant on the remote 
computer 

Quick keystroke: F3



Configure Call Costs

Your time on-line will be logged automatically without the need for you to take any special action. 
However, you should check the options in the Configure menu to ensure that the settings are correct for 
your system.

 Only users who have Connect admin permission can make permanent changes to these settings or 
to the actual Call cost records.

Choose the Carriers option from the Configure menu and ensure that the correct carrier is associated with
each Connection you use. The carrier is set to BT basic rate (local) by default. If you need to change 
carrier, click one of the Alter buttons: if the carrier you want is not shown, click the More button to see the
full list of tariffs. See also Format of the tariff files.

To set automatic dates for subtotalling e.g. to match the dates of your telephone bills, choose the 
Subtotals option.

The Expiry option enables you to set if and when detailed records should be deleted and replaced by 
summary information.

Improve the accuracy of your records by recording the Delay that occurs on your system, between the 
start of dialling and the point at which the remote machine answers the call.

Related Topics
Call costs
Call costs Menus
Configure menu 
Format of the tariff files



Configure Email send and receive dialog

This dialog is called by selecting Email Transfer from the Configuration menu. 

Data will be set for your initial mail account from the script installed for your Access Provider and from the 
answers you may have given when your Access Provider was first selected. 

The Configure Email send and receive dialog enables you to confirm the settings made and when 
necessary to change them. The associated Configure POP3 Mail Collection dialog enables you to setup 
further POP3 mailboxes as you require.

 If you are in any doubt about any setting, you should contact your Access Provider.

· Sending email by SMTP
Mail gateway.    This is your current Access Provider's Mail gateway.
This will change automatically if you select a different Access Provider.

Send automatically.  When this option is checked, any mail that is waiting in an out tray will be 
automatically sent after the time set, after you go on-line. If you want mail to be sent only when you 
prompt for it, this option should be clear.

· Receiving Electronic Mail
Determined by the Access Provider you use, you may receive all your mail by SMTP or you may have
one or more POP3 mailboxes from which you want mail to be collected. Your Access Provider will be 
able to advise you on whether to receive mail by SMTP or to use POP3 mailboxes.

Receive automatically: If you want any mail that is waiting for you to be automatically collected 
whenever you go on-line, check this option. If you want mail to be collected only when you prompt for 
it, clear this option. 

SMTP, POP3. Select the type of mail service you use.

Demon users should check either SMTP or POP3 but not both. When both are checked you are asking 
Demon to send two copies of messages. You will receive a message informing you that a message has 
already been sent.

With SMTP collection enabled.
When you enable SMTP and check the Return Receipt to option, a message receipt will be 
automatically sent (in response for a request for one). 

When this option is selected a receipt is sent automatically with no user intervention. Although you 
can use this option, for a better method that is under user control refer to MDN in Turnpike Help

The DSN option is similar to a function implemented by ESMTP and is not currently supported by 
Demon Internet.

With POP3 collection enabled



To add an account, click the Add button and then complete the Configure POP3 Mail Collection 
dialog.    

To edit account details, select the Edit button. This will also display the Configure POP3 Mail 
Collection dialog, enabling you to change the details of the selected account.

To remove an account, select the account and then click the Remove button.

Move up, Move down Use these buttons to change the order of accounts. Connection will be 
made in the order set.

Enable POP3 server: to enable the POP3 server check this box. This will allow users of your system 
to access their mailboxes from outside Turnpike. 

To access this facility the Serve POP3 permission must be explicitly set for each user.
Consider this option carefully before selection. When selected it will open a route whereby people 
from outside could access your users' mail.

Produce debug information: Check this box if prompted to do so by your Access Provider's technical
support department.

Click the OK button to confirm the settings

Related Topics
Sending and Receiving Mail
POP3 Server Option
Configure POP3 Mail Collection.



Configure Menu

Host
Timezone
Email Transfer 
News Collection
Service Access
Site Key
Telnet Emulation
Telnet Keyboard
Toolbar buttons

Related Topics
Configuring Turnpike Connect



      
Configure Menu Telnet Keyboard

When you have Administrator permission selection of this 
menu option will display the Telnet keyboard dialog.



Configure News Server dialog

This dialog is called when you click either the Add button or the Edit button on the Configure Usenet 
News dialog. 

1. Enter or edit the Server name.
2. If required enter or edit the User name and a Password.

 
The Server Name must be unique
Each User Name for each server must also be unique

3. Set the following options

Use NEWNEWS commands. If the server is Demon this option will be set by default. Generally
for other servers this will not be set. If you are in doubt contact your news supplier.

Update newsgroup list at next connection. Check this option to pick up a fresh newsgroup list.

Retry every xx    minutes Set this to a time that suits you. The default set is 10 minutes

4. When you are satisfied with the settings, click the OK button to save.

Related Topics
Configure Usenet News 



Configure POP3 Mail Collection

This dialog is called by selecting Add or Edit from the Configure email send and receive dialog.

Details such as where mail needs to be picked up from for your initial mail account is set from the script 
installed for your Access Provider and from the answers you may have given when your Access Provider 
was first selected.

Server name.  Typically POP3.demon.co.UK

Username. Enter your hostname, i.e. if your domain is sample.demon.co.uk, enter sample. If you 
wish to collect mail for just one user on your system, enter user+hostname e.g. fred+sample.

Password Enter a suitable password for Demon not your Turnpike password. However, if you have 
set a special POP3 password e.g. to access your mail when away from home, enter this password 
instead.

Use 'APOP' authentication: if your Access Provider offers APOP authentication (to avoid 
broadcasting your password), this option should be checked. If you are unsure, consult your supplier

Fetch all, Mirror : Choose between having the mail downloaded to your Access Provider machine i.e.
fetched or left in your POP3 mailbox so that it can be seen from another site e.g. home as well as 
work. 

· Fetch all.    When your machine receives mail, the messages currently in your POP3 mailbox will 
be copied to your system and then deleted from the POP3 mailbox. Check this option for email to 
be deleted from Demon's server when it has arrived on your machine. 

Mirror is useful if you want to dial in and read your mail from more than one place. 

Retry every: Enter how often you want Turnpike to look to see if new mail has arrived while you are 
on-line. The default of 15 minutes represents a reasonable compromise between spending a lot of 
time looking and not missing messages that arrive while you are on-line.

Related Topics
Sending and Receiving Mail
POP3 Server Option
Configure email send and receive dialog



Configure Service Access

When you select Service Acces from the Configure menu, the Access Provider dialog appears. This 
dialog enables you to set/edit the following details about your account. 

· Login name
· IP address
· Login Password
· Domain Name server(s) you are using

You are only able to access these options when you have Admin permission.

The information given is taken from the script for this Access Provider together with the answers given 
when this Access Provider was first selected. If any of the settings are given as Automatic this means 
that these are set directly from information exchanged when you connect to your Access Provider.

While you are unlikely to need to change any of the information given in this dialog, you are able to 
change the password given here if you wish. You can also change the DNS addresses here if instructed 
to do so by your Access Provider.

To switch the current connection to an alternative Access Provider, click the Alter button and select from 
the drop-down list.

To make a new connection, click the New button and complete the Configuration questions. 

Related Topics 
Making a New Connection
Access Provider dialog
New Connection dialog
Edit Connection dialog



Configure Usenet News dialog

This dialog is called up by selecting News Collection from the Configure menu. Use this dialog to set 
where you will get Usenet news articles from and how news will be handled. You are also able to cancel 
article requests.

The address of your initial server is taken from the information given in the 'script' for your Access 
Provider. This dialog enables you to download news articles from up to eight different servers.
 

 
For a server to be active, the box to the left of the server name must be selected (ticked)

· Common details for selected server(s) 

Automatic collection: When checked, any new articles will be automatically copied to your disk 
whenever you go on-line.

Automatic expiry: When checked, Turnpike will automatically expire any old news articles 
whenever you run Turnpike Connect.

Automatic posting: When checked, any mail/articles in your out tray will be posted

Produce debug information. Check this box when prompted to do so by your Access Provider's 
technical support department.

.
Mail moderators @: The address to which contributions to moderated newsgroups will be sent.

News Servers
A list of servers from where you are able to choose to get your news feed.

You are able to subscribe to a newsgroup available from one or more of the news servers selected in this 
dialog. For further details see Newsgroup Subscription dialog in Turnpike Help. 

· To Add a News Server
Click the Add button to display the Configure News Server dialog

· To Remove a News Server
1. Highlight the server in the News Servers list
2. Click the Remove button
3. Click the OK button
 

· To Edit News Server options
1. Highlight the server in the News Servers list 
2. Click the Edit button to display the Configure News Server dialog 
3. Set/reset the options as required.

 
Use NEWNEWS commands If the server is Demon this option will be set by default. Generally



for other servers this will not be set. If you are in doubt contact your news supplier.

4. Click the OK button.
 

· Move Up/ Move down
Connections are made in the order listed and may be limited. Use these buttons to set the priority for 
the initial connection.

Related Topics
Article Requests
Updating the list of newsgroups
News service details
Difficulty Connecting
Browsing a Newsgroup
Moderated Group



      
Configure menu - Telnet Emulation

When you have Administrator permission selection of this 
menu option will display the Telnet Sessions default   dialog  .



      
Configure menu: Email transfer

When you select this option the Configure email send and receive
dialog is displayed. Use this dialog to set whether mail is sent or 
received automatically or just when you prompt for this to happen.
When receiving mail you are able to select either SMTP or POP3 
and whether to honour requests for a Return Receipt. For POP3 you
are also able to Add/Remove servers.

You are only able to access this option when you have 
Connect Admin permission.



      
Configure menu: Host

The Host configuration dialog enables you to see and, 
where appropriate, set your local domain, the domain name of
the machine you use (your host machine) and the domains for
which your machine will accept mail.

You are only able to access this option when you have 
Connect Admin permission.

For further details see Host configuration dialog.

      

Configure menu: News collection
When you select this option the Configure Usenet dialog is 
displayed. Use this dialog to set where you obtain Usenet news
from, and select for new news articles to be automatically 
copied to your disk whenever you go on-line.

    You are only able to access this option when you have 
Connect Admin permission.



      
Configure menu: Site Key

When you select this option the Site Specific Details dialog 
appears. This dialog enables you to inspect, and if necessary 
change, the basic registration information about your system 
including the Site ID, the Site Key and the Password.

You are only able to access this option when you have 
Administrator permission.



      
Configure menu: Timezone

If you have Connect Admin permission you will be able to 
access the Timezone dialog by selecting Timezone from the 
Configure menu. The Timezone dialog enables you to set the
timezone you are working in and any summertime rules which
may apply.



      
Configure menu: Toolbar buttons

The Toolbar Configuration     dialog box enables you to add, 
remove or re-assign the buttons on the Connect toolbar.

 You are only able to access this option when you have 
Connect Admin permission.



Configuring Turnpike Connect 

There are many aspects of Connect that your are able to configure to suit your needs. Some features are
set from the main Turnpike program. Some only apply when several people share the same system.

· Configuration features set from the Connect program
· Details of the Host, including your local domain
· What time zone you work in
· Access Providers and Connections
· Email Transfer
· News Collection
· Add new and alter details of your Access Provider
· See and change your Site Key
· Telnet functions
· Add/Remove Toolbar buttons

For details of the following features select Help from the main Turnpike program
· Set Permissions
· Adding new users and the sign-on names they use.
· Setting up workgroups
· The range of email names recognised by your system
· The email names recognised by your system
· Who can use specified email names
· Where mail messages for each email name are routed

Related Topics
Configure Menu



Connect to Internet dialog

The following applies where Turnpike is used to dial. If you use another supplier’s software to 
dial, refer to the literature provided by that supplier.

When you initially load Connect, and where applicable have signed on, the Connect to Internet dialog is 
displayed super-imposed over the main Connect display. 

If this dialog is not shown and you want to go online, click the button with the telephone icon located in the
upper left of the main Connect display, under the toolbar. The Connect to Internet dialog will then 
reappear.

Turnpike will dial the connection shown for you, and then go online. When the connection is established, 
the Connect to Internet dialog will close, exposing the Main Connect Display.

· To change settings in the Connect to Internet dialog:

1. If the autodialling starts, click the Dialling status Stop button.

2. Connection Confirm this is the connection you want to use. If you want to use a different 
name, click the down arrow In the Connection box and select a name from the list.

3. If the Access Provider you want isn’t listed, click the New button to display the New Connection 
dialog.

4. To confirm/change details of the selected connection, and to see which Access Provider is being 
used, click the Edit button to display the Edit Connection dialog.

 
If you have one connection to one Access Provider, the Connection name will be the same as the 
Access Provider by default. You can change the connection name if you wish. If you have more 
than one connection to an Access Provider you must use different names for each Connection.

Details button Click to expand/collapse a box at the bottom of the dialog. Set the following as 
required:

Auto dial If you want Turnpike to automatically dial for you, check this option. If you want a delay
before dial up starts, set a time in seconds. 

Options
Redial count The default set is 5. You can also change this if you want.

Debug script Check this to produce a report should you have problems connecting.

Disconnection:
Idle timeout The default is set to 120s. You can change this if you want.

Exit after disconnect
Check this box if you want Connect to close after disconnection.

 



Connect will wait for News filing to finish before disconnection.

· To dial the Connection
If the auto dial option has been set, Turnpike will auto dial for you. If this has been disabled, click the 
dialling status Start button. If the auto dial is not set, just click the Connect button.

Turnpike will initialise your modem and dial up your Access Provider. Turnpike will try dialling again, 
up to the number of Redials you entered in the dialog. If the No dial tone or No carrier messages 
persist, or if the number remains engaged, click the Connect button again or try again later. During 
the redial attempts, you are able to click the Redial now button to reset the redial counter and 
continue to redial.

Messages in the lower half of the details section of the dialog show the progress of the connection.

Related Topics
Mail and News Service Indications and Controls
New Connection dialog
Edit Connection dialog
Making a new connection
Difficulty connecting
Errors
Configure Email Transfer



Connection settings

· UK PoP phone numbers
If the PoP you want is new or has changed its phone number, the number you require may not be 
included in the drop down list of Points of Presence in the Edit Connection dialog or New Connection 
dialog.

If you know the new number or want to enter the phone number of a PoP you know, type this number 
over the one currently shown in the Phone number slot. Take care to type the correct number.

· Area Code and Country settings
The settings for the phone area code and the country you are dialling to, are set by selecting Dialup 
Networking (DUN) from My Computer or by selecting either:

Windows 95 Start Menu/Programs/Accessories/Dialup networking.
or
Windows 98 Start Menu/Programs/Accessories/Communications/Dialup networking.

1. Double-click on the DUN icon you use to display the Connect to dialog.
2. Click the properties button to display the Dialling properties dialog.

The phone number shown in the Connect to dialog and the Area Code and Country given in the 
Dialling Properties dialog for the Default Location will have been entered by you when you installed 
your first modem.

· To dial from additional locations.
Where I am
1. Click the New button on the Dialling properties dialog and enter a name you will remember in the 

Create New Location dialog;
2. Enter the area code you will be dialling to;
3. Select the country you will be dialling to the drop down list.

How I dial from this location
Accept the default options set, or choose options to suit your location.

When you are satisfied with the entries set, click the OK button to save.

Related Topics
Making a New Connection



DEC/PC layouts (in Telnet)

If your PC is set to emulate a DEC terminal when you telnet to a remote computer, its keyboard is 
automatically set up to mimic the keyboard used on a DEC terminal.

The important difference between the keyboard used on a PC and that used on a DEC terminal is in the 
numeric keypad, which on a DEC keyboard is like this:

The effect of setting the PC keyboard to mimic the DEC keyboard is that:
· The four keys at the top of the PC keypad (Num Lock, /, * and -) act as the DEC PF1 - PF4 keys. The 

Num Lock key continues to switch the Num Lock light but it doesn't have any effect on the keypad 
keys.

· The 'number' keys of the keypad either generate the numbers shown or the appropriate escape 
sequences, depending on the mode selected by the remote computer.

· The grey '+' key on its own acts as the DEC '-' key, or with Ctrl, as the DEC ',' key.

If you prefer, you can set the keyboard to have its usual PC layout by taking the Keyboard option from 
the Options menu and selecting PC layout in the VT100 keyboard layout area of the dialog that is 
displayed. The effect of this is as follows:

If the PC layout is selected and Num Lock is set:
· The 'number' keys and the grey '/', '*' and '-' keys either generate ascii characters or the appropriate 

escape sequences.
· The grey '+' key acts as the DEC ',' key.
· Function keys F5 - F8 act as the DEC PF1 - PF4 keys. (Note these keys only work as PF1 - PF4 

when Num Lock is set.)

If the PC layout is selected and Num Lock is not set:
· The grey '/', '*', '+' and '-' keys generate ascii characters
· The Up, Down, Left and Right keys act as alternative cursor keys
· Home, End, PgUp, PgDn, Ins and Del don't have any effect.

Related Topics
Keyboard layout choice
Introduction to telnet



Defining function keys (in Telnet)

Some of the function keys are pre-set to issue some of the more common commands you may require 
when using Telnet. To set up other function keys to give standard commands for you, select the 
Keyboard option from the Options menu and then type the command strings you wish these keys to give
in Telnet Keyboard dialog.

The function keys give different commands in combination with the shift keys Shift, Ctrl and Alt.    Use 
the options to the right of the list of function key meanings to select the shift state (Normal, Shift, Ctrl 
and Alt) in which you are setting this meaning.

Related Topics
Telnet Function Keys
Introduction to telnet



Demon Trial Account Setup - Account Details

If you would prefer to pay by cheque (annual subscriptions only) contact Sales Registration.

The Wizard can only set up an account for you if you enter the details for a direct debit or enter the details
of a valid credit card. Visa, Access or Mastercard credit cards are accepted.

Click the down arrow and select the appropriate title (Mr, Mrs, Ms etc.) from the drop-down list, or type up 
to 7 characters in the Title slot.
Enter the appropriate information in the other slots.

1. You must fill in your Title, Forename, Surname, Address and Postcode. The entry for Organization
may be left blank.

2. If the appropriate title isn’t included in the drop down list, select Other.. In the adjacent box enter a
title using no more than 7 characters. Don’t use the Other option when your title is available in the
Title box.

3. Details must be entered in the same form as they are known to your credit card company or your 
bank.

Demon Internet uses this information for sending you complementary copies of the Dispatches magazine 
and other relevant literature.

Click here if you need any further information.



Demon Trial Account Setup - Contact/Security

Enter phone numbers and extension numbers as simple strings of digits. You can have spaces in the 
main phone numbers. You can also give the International form of the number if you wish (+xx....).

You must enter at least one contact number.

Enter a short security phrase (no more than 30 characters long - including spaces). The phrase should be
easy for you to remember but not easy for someone else to guess. You use this phrase to identify yourself
when you want to ask Demon Internet to make changes to your account over the telephone.

DON'T tell other people your security phrase.

Click here if you need any further information before making your selection.



Demon Trial Account Setup - Credit Card 

This dialog appears when you choose to pay by Credit Card.

You must enter a valid card number and it's expiry date.

The card must be either Visa, Access or Mastercard, and it mustn't be due to expire before the end of 
your free period.
Only expiry dates from the current date to 10 years hence are accepted. Any other date entered is 
assumed to be an error.

The Title, Surname, Address and Postcode shown will be as entered in the details entered ealier.

Details must be as known to the relevant Credit Card company. If are using someone else's card to pay, 
check the Different Cardholders details box and enter the new details. 

Check that the details shown are correct for the Credit Card you've opted to use.

It's important to ensure that these details are correct. If the information you give isn't valid, your free 
trial account will be cancelled.

When you are satisfied that the details are correct, check the option to Accept Demon Internets 
Conditions of Use and to authorize Demon Internet to charge your credit card.

If you would prefer to pay by cheque (annual subscriptions only) click here.

Click here if you need any further information.



Demon Trial Account Setup - Hostname

Two things are under consideration here - the 'hostname' for your computer and the password associated 
with your Demon account. 

This password is not the password you set earlier for running Turnpike. It is recommended that you set a 
completely different password. Someone with knowledge of your Demon password will then not be able to
access to your Turnpike files or vice versa.

For specific advice on choosing your hostname or choosing your Demon password, click the associated 
Advice button.

Make a note of the password you set.

Click here if you need any further information.



Demon Trial Account Setup - Hostname Advice

Hostnames can be between 3 and 16 characters long.

You can use any mixture of lower-case letters, digits and hyphens except you must start with a letter and 
you mustn't end with a hyphen or have two hyphens together.

Ideally, use a hostname that clearly represents you, but don't be surprised if your first name or your 
surname has already been taken.

It's worth taking care over choosing your hostname because Demon will charge an administration fee for 
changing your hostname later. They also reserve the right to cancel your account if the name you choose 
is in any way offensive.

Ultimately, you will get to pick your hostname from a list of available hostnames that are at least similar to 
the ones you suggest, so it's a good idea to use the slots offered here for a range of possible names, 
rather than for 6 very similar ones.

Click here if you need any further information before making your selection.



Demon Trial Account Setup - Hostnames

This list shows the hostnames you suggested, perhaps together with some other possible names.

If a hostname you suggested is available for you to use, it will be ticked. If it isn't available, it will be 
marked with a cross and followed by a list of similar names which are available. The list may include 
some similar names also not available. 

Select the hostname you'd like to use - or click Redo to suggest further possible hostnames.

Take care choosing your hostname and make a note of it. Demon will charge an administration fee if 
you want to change it later. Demon also reserve the right to cancel your account if the name you 
choose is in any way offensive.

Click here if you need any further information before making your selection.



Demon Trial Account Setup - Marketing

We would appreciate it if you gave the details requested here. 

It is not necessary to fill in this page to complete the installation.
.



Demon Trial Account Setup - Payment 

You must then choose whether to pay monthly or to pay annually.

If you would prefer to pay by cheque (annual subscriptions only) click here.

Card Type 
· Specify whether it is a company or personal credit card.

Payment frequency
· Set whether you would prefer to pay monthly or annually.

 
VAT receipts cannot be issued for monthly payments.

Reference
If you want a particular reference number to be quoted on any invoices, enter this here.

Click here if you need any further information. 



Demon Trial Account Setup - Review

To review the answers you've given on the previous pages, click the Back button.

To finish this part of the procedure, and go on to the next, click the Connect button.



Demon Trial Account Setup - Terms and Conditions

Read these terms and conditions carefully.

Now check the box as confirmation.

See also the TERMS&C.HTM file in your Turnpike directory. You can display and print this file using 
Microsoft Internet Explorer or another Web browser.

Click here if you need any further information before making your selection.



Demon Trial Account Setup - Welcome

The Wizard takes you through a series of steps that:

· Take your name and address
· Enable you to set how you'll pay for your account at the end of the Trial period
· Record your choice of 'hostname', 'password' and 'security phrase' to be associated with your account
· Take you through a set of screens which get you to confirm the hostname you will actually use.

Enter the required information or make the appropriate selections required for each stage of the Wizard, 
then click the Next button. 

To go back to a previous screen, click the Back button.

If you click the Cancel button a message will ask you whether you really want to exit from this Online 
Registration procedure. If you click No, you will restart the Online Registration procedure from this screen 
but with all the information you typed before already in place.

Clicking the Help button to get further information about the selections you are currently being asked to 
make.



Dial-up script for Windows NT4
If you dial up using the Windows NT4 RAS, you will need to setup a dial-up script similar to the following. 
The example given here is the one you will need if you use Demon as your Access Provider. The script for
other Access Providers will be similar.

[Demon Internet]
COMMAND=<cr>
ERROR_NO_CARRIER=<match>"NO CARRIER"

OK=<match>"ogin:"
LOOP=<ignore><cr><lf>
COMMAND=insertyourhostnamehere<cr>

 or COMMAND=olr<c>          (if about to sign up for Trial account)

OK=<match>"word:"
COMMAND=insertyourpasswordhere<cr>

 or COMMAND=olr<c>          (if about to sign up for Trial account)

ERROR_NO_CARRIER=<match>"NO CARRIER"
OK=<match>"otocol:"
COMMAND=IDLE=600,PPP<cr>

OK=<match>"PPP"
CONNECT=<match>"HELLO"

Save this as a text file called switch.inf within your RAS directory (usually c:\winnt\system32\ras)

In the above script, the idle=600 instruction sets the Idle timeout at your Access Provider to 600 seconds 
or 10 minutes. You are free to set a different time if you wish.



Dialling up from idle

To dial up from idle, click the Connect button on the main Turnpike Connect display. 

· If your system is set up to use Turnpike to dial
When you have signed on the Connect to Internet dialog will appear. Click the Connect button in this 
dialog, or, if autodial is set, allow Turnpike to dial for you. When the connection is established the main
Connect screen will appear. This uses an internal script located in the Turnpike .ACC file.

· If Turnpike isn’t used to dial
An external script is used. How this is set, depends on how you use Windows 95. When you go on-
line, the Connect to Internet dialog will appear as above, however some of the details may not be 
shown.

Related Topics
New Connection dialog
Edit Connection dialog
Connect to Internet dialog
Mail and News Service Indications and Controls
Making a new connection
Difficulty connecting
Errors



Difficulty connecting

If you experience difficulty connecting, you will probably see one of these messages in the Progress area 
of the Connect to Internet dialog:

ERROR your modem hasn't responded to the initialisation sequence, perhaps because it isn't 
switched on or perhaps because it isn't plugged into the correct port on your PC.

NO DIAL TONE the modem hasn't been able to get a dial tone.

BUSY the number is engaged. You may also get BUSY if the number it is dialling is 
unobtainable.

NO CARRIER the modem hasn't had any response from the modems at your Access Provider's PoP.

· If the error is not obvious check the following:

Turn up the volume on your modem, check that you hear the dialling tone and then the Access 
Provider's equipment answering. If you don't, click on the dialling button and check the settings in the 
Dial settings dialog.

Access Provider has a number of PoPs (Points of Presence) confirm that you've selected the 
appropriate one. See Edit Connection dialog.

Windows 95 Control panel. Check settings such as the port used.

· If you continue to have problems
Contact your Access Provider. You may be asked to select the Debug script option selected in the 
Connect to Internet dialog and then asked to try dialling again. The main window will then display the 
commands that Turnpike sends. From these commands your Access Provider will be able to work out 
what changes are required (if any) to enable you to dial up successfully. Any changes may mean a 
change to your Access Provider script.

Related Topics
Installing a new Access Provider script
New/Edit Connections dialog
Troubleshooting



Domain Name Servers (DNS)
Domain Name Servers convert the domain names used to specify 
where a message needs to be sent, into the IP addresses that are 
actually used to direct messages etc. across the Internet. 

They are identified in the Access Provider dialog by quoting the IP 
addresses of the computers on which they run.



      
Domain name
The multipart name that gives the address of a 
computer on the Internet by identifying its position 
within the Internet's Domain structure. For further 
details refer to Domains and Hostnames.



Domains and Hostnames

In the email address: RonD@hq.msfc.nasa.gov the hq.msfc.nasa.gov part is the hostname.

Hostnames are based on Internet Protocol (IP) addresses. Each hostname identifies a 
particular machine (server) on the Internet. Each server connected to the Internet also has a
numerical IP address. The IP address comprises four sets of numbers connected with dots. 
For example, the IP address for the mail server at the University of Alabama is 
130.160.4.100.

Because names are easier to remember than numbers, the planners of the Internet's mail 
transport protocols (standards) created the hostname system. The part of an Internet 
address to the right of the @ is often referred to the domain for the address. Everything to 
the right of the @ is more properly referred to as the hostname.

The hostname is paired with a specific IP address. The domain refers to an entire physical 
location, or site, where the connection, or Point-of-Presence (PoP), with the Internet occurs 
for example, Turnpike.com.

Note. Some domains don't use registered hostnames; you have to address email to them by
their IP numbers. Fortunately, the use of hostname addressing predominates.

Domain types are typically the organisation and the nation where the domain is located. Some examples 
are:-

.GOV US Government

.EDU Educational sites

.COM Commercial sites

.ORG Organisations that don't fit into other categories

.UK United Kingdom

Domain names are registered with the InterNIC.

Generally, if the address does not end with a register abbreviation similar to those listed above, it is NOT 
an Internet email address. However, you may still be able to send mail to non-Internet addresses through 
an email gateway service such a Compuserve.



Edit Connection dialog

The Edit Connection dialog appears when you click the Edit button on the Connect to Internet dialog.

The Edit button will only be active if you have dialling Admin permission.

The details in the New and Edit connection dialogs are similar, the dialogs differ only in dialog name 
and usage. If you want to use a New Access Provider refer to the New Access Provider dialog.

Complete the following dialog entries:
· Connection; Select the down arrow and select from the list.

The case of the connection name is ignored. 
The name entered must be unique.

Use Turnpike dialler. If you are using Turnpike to dial, the option box should be checked, see Dialling
up from idle.

· Modem: Enter the modem you are using. 

To switch to a different installed modem, click the down arrow and select modem from the drop-
down list. 

If you are using ISDN, check the associated box.

If you uninstall a modem using the Windows 95 control panel, that modem will remain in Turnpike's 
memory and hence in the list of modems in the Edit Connection dialog, until you select a different 
modem from the list. If you then try to connect using a modem that is listed but has been uninstalled,
an error message dialog will appear.

Select any other modem from the modems list in Edit Connection dialog then click the Save button.
Click the Edit button on the Connect to Internet dialog again and only those modems currently 
available will be listed. 

To install a new modem click the Install Modems    button and then follow the Windows 95 Wizard.

· Access Provider: as set in the Internet Access Provider dialog.

· Point of Presence (PoP). This is where you dial to connect to your Access Provider. Click on the 
down arrow and select a name from the list - the phone number will be filled in automatically.

If the PoP you want is new or has changed its phone number, the number you require may not be 
included in the list of Points of Presence. If you know the new number, type the new number over the
one currently shown in the Phone number slot. DO NOT amend the Point of Presence or the number
you have typed will be lost. Take care to type the correct number.



When you are satisfied with the details entered click the Save button.

· Changes made at the Access Provider end of the connection

The information used to contact your Access Provider is taken partly from the 'script' file for this 
Access Provider and partly from the answers given to the sequence of questions Turnpike asks when 
you make a new connection. 

If changes are made at the Access Provider end of the connection - for example, the provider 
changes any of the following:

· Address of their mail gateway
· IP address of a DNS server
· New PoPs are introduced or they change the phone numbers of existing ones, then these 

changes will be in the latest version of the Access Provider's script file.

Ensure you don’t miss any news. The range of news articles held at any time differs from news 
server to news server. When you change the Access Provider you use, you should also set the Last 
NewNews date in the Newsgroup Subscriptions dialog back a day or so - at least for those 
newsgroups you're most interested in.

Related Topics
Access Provider dialog
New Access Provider dialog
Which modem to pick
Changing POP3
Connect to the Internet Dialog
Newsgroups subscriptions
Installing a new Access Provider script
Connection settings



Edit menu

Copy
Paste



Edit menu: Copy
Copies the currently-selected section of the record
of commands and responses. Enables you to 
copy logging records and call cost details.

Quick keystroke: Ctrl + C



      
Edit menu: Paste
Inserts a text copy of the information copied from the 
logging or call costs displays

Quick keystroke: Ctrl + V



      
Email names

The email name (written before the @ in the email address) identifies the user to which a 
particular piece of mail is being sent. This 'name' can include digits and some punctuation 
marks but not spaces or commas. It must be different from other email names used on your 
system.

Each user usually starts with just one email name, but it is often useful to add others - e.g. for 
dealing with friends, business colleagues, sales enquiries, Usenet postings ... and so on.

On a multi-user system, you can also arrange that some email names are private i.e. can only
be used by one person. You are also able to arrange for email names to be used by a whole 
range of people - for example allowing everyone in a Sales department to both send out and 
process messages from sales@yourcompany.com. Mail based on email names with multiple 
users is known as Group Mail and is a powerful feature of Turnpike.

One email name is set when you install Turnpike. Others are setup (and changed) from the 
main Turnpike program. Assuming you have the appropriate permission, you select Configure 
from the File menu of that program, then pick Email names from the submenu that appears. 
This calls up the Email names dialog which gives a list of all the email names currently in 
use, together with a Create button through which new names can be setup and an Edit button 
to use to change any aspect of names which have already been setup. Selecting either of 
these options calls up a Usage of email name dialog in which the details of the email name 
can be set.

For further information, see the section on Special features for multiple users in the 
Turnpike Mail&News book.



Enhancing the speed of Mail and News collection

While news is being collected you will see a message giving the speed of collection in 
characters per second (CPS) and the percentage complete. If the figure remains around 0 for
a lot of the time, you've dialed up at a very busy time. A figure will also show the number of 
errors, (unless you have chosen to use the comm.drv option for your modem).

Ideally, you should be getting between 1600 and 3000cps with a 14400 modem (depending on the 
amount of encoded or compressed information that's being transferred) or twice that with a 28800 
modem. If the rate of collection is lower than this, and maybe even dropping to zero at times, the problem 
could simply be that you have dialed up at a very busy time. Try again at a less busy time.

If filing the news is taking a long time, try defragmenting your hard disk. Try using a recent version of 
SMARTDRV, or some other disk cache; enable write caching.

If you are using a disk compression program such as Stacker or DoubleSpace, this will be making filing 
slower. It would be better to arrange that your news and mail are stored on an uncompressed section of 
your hard disk. Articles would then be filed much faster at a cost of very little extra disk space, news and 
mail files are already compressed.

Remember Turnpike isn't simply writing the information to disk: it is also encrypting your mail for privacy, 
compressing it and indexing it ready to give you easy access when you come to read the articles.

Related Topics
Troubleshooting



Errors and Overruns

While news is being transferred, messages on the news area of the main Connect window show how 
many items to expect, how many have been collected, and how many have been filed. When transfer is 
complete, data states the rate at which data was transferred in characters per second (cps) and reporting 
errors (overruns) in this transmission (unless you have chosen to use the comm.drv option for your 
modem).

Each error represents a character lost, because your PC is not able to transfer it to memory before the 
next character turns up. Such errors are known as overruns and they have a bad effect on the speed at 
which you collect data because, whenever an error occurs, a whole packet of some 500 characters has to
be re-fetched. Moreover, the packet can't necessarily be re-sent immediately, so a single lost character 
can cause a great deal of delay.

There are three ways of getting rid of overruns:

· Reduce the serial link speed
The serial link speed is set in the Windows 95/98 Control Panel. If your PC can cope, this speed 
should be set at least four times the modem speed. If not, then setting a lower speed will make the 
characters turn up at longer intervals: for example, changing from 115200 to 38400 would give your 
PC three times as long to deal with arriving characters. There is only a marginal advantage in running
14400 modems above 38400 or 28800 modems above 57600, so it is worth trying these speeds.

Running at less than twice the modem speed is not an ideal solution because this takes it below the 
rate at which the modem is trying to transfer data. Because modems compress the data stream 
across the phone lines, even a 14400 modem will regularly give you 3000cps or more for text 
transfers, while running at 19200 will restrict performance to a mere 1920cps and create an unwanted
bottleneck. So even if you find that dropping the serial link speed below twice the modem speed 
improves performance by getting rid of overruns, you need a longer term solution.

· Arrange that your PC reacts faster
To improve the responsiveness of your PC you need to identify the software that is stopping it 
responding to interrupts as fast as it should. The usual suspects are the disk driver; the video driver 
(especially old S3 drivers) and software designed to improve disk performance (because some of this 
improvement may come at the expense of the performance of the rest of the system).
The first thing to do is to get the latest drivers for your hardware, as the ability to work alongside high 
speed comms has only become a requirement relatively recently.

· Fit a serial chip with more buffering than a 8250
Actions you may like to try include;
· Turning on 32bit disk access (and 32bit file access in WfWG)
· Using SMARTDRV caching
· Turning off the IDE Block Mode Transfer option in the BIOS.
· Removing special disk controller cards 

If your PC uses an 8250 serial chip, the advice is to replace this by a 16550A or equivalent "high-
speed" serial chip. The 16550A contains a 16 byte buffer, so your PC has many times longer to 
respond to incoming characters. If you still get overruns after upgrading this chip, you need to turn 
your attention to your disk and your video driver as described above.

Related Topics
Enhancing the speed of collection
Mail and News Services



Troubleshooting



Expiring News

Before downloading new news articles, you will probably want to erase from your disk any news articles 
that have passed their Expiry date.

You can arrange for this to happen automatically whenever you run the Connect program - or you can 
arrange that news is only expired when you prompt for this to happen.

If you have Connect Admin permission;

· Arrange for news to be expired automatically
1. Click on Configure.
2. Select News collection the Configure Usenet News dialog appears.
3. Check the Automatic expiry option.

If you want news to be expired only when you prompt for this to happen leave the Automatic expiry 
option clear. Select the Expire News option in the Services menu to prompt Turnpike to expire the news 
when you want this to happen.

While the old news articles are being deleted, you will see messages at the bottom of the screen 
recording Turnpike's progress.

· To change the length of time the articles from a particular newsgroup stay on your disk
Set a different Expiry time for the group in the Newsgroup Subscriptions dialog. For further 
information, see either the Turnpike Mail&News book or call up the on-screen Help from within the 
main Turnpike program.

· To keep particular articles past their Expiry date
In the main Turnpike program select the articles within the appropriate newsstand and use the Keep 
option in the Article menu to mark them to be kept. For further information, see either the Turnpike 
Mail&News book or call up the on-screen Help from within the main Turnpike program.

Related Topics
Configure Usenet News dialog



Expiry
News articles are only kept for a limited amount of time, after 
which they are erased from the newsbase. The date at which 
a news article is due to be erased is known as its Expiry Date.
This is calculated from the date the article was downloaded 
and the Expiry time currently set for the group in the 
Newsgroup Subscriptions dialog. The process of erasing 
those articles that have passed their Expiry Date is known as 
Expiring the news.



FTP

File Transfer Protocol (FTP) is the facility that enables you to upload and download files to and from a 
remote computer across the Internet. The program supplied with Turnpike that enables you to transfer 
files in this way is called WS-FTP Pro.

A wide range of files are available for you to copy over the Internet including public archives, pictures, 
maps, 'shareware' and 'public domain' programs. Details of the files that are available may appear in 
articles in Usenet newsgroups, catalogues of Internet services or other on-line or printed information.

There's also a system known as Archie that can be used to search for files available free through a 
system known as Anonymous FTP.

· To transfer a file:

1. Click the WS-FTP button on the Connect program toolbar.
2. Enter the remote computer's address, the appropriate log-in name, password, account etc.in the 

dialog that's displayed - or pick from the drop-down list of predefined 'Session Profiles'.
3. Click OK to connect to the selected computer.
4. Open the directory containing the file (or files) you want to copy and the directory into which you 

want to copy them on the main FTP screen.
5. Drag and drop the files you want to transfer between the directory on the Remote system and the 

one on your Local system (or use the Arrow buttons between the two lists if you prefer).

For further information about using FTP, press F1 after you have called up the main FTP screen to call up
the WS-FTP software's own Help information. This information is held separately from this Help file.

Related Topics 
Hints and Tips on using FTP



FTP: Hints and Tips

Working out which file to copy may not be easy if there are a number of very similar entries.

When there are a number of very similar entries, check the following before deciding which file(s) to copy:

1. That the file is in a suitable format for use on your machine. A program that has been set up for a 
Macintosh is absolutely no use on a PC!

2. That you will be getting the latest version.

3. The file is coming from a reputable source. The last thing you want is to copy a file that's been 
infected with a virus.

4. If the file is compressed.

· Compressed files

Look at the filetype. A file that has been compressed using the PKZIP program will have the filetype .ZIP, 
while a file with the suffix .tar was created using a tar command and contains a compilation of files. 

To make use of these files, you will need the appropriate tools available on your computer to 'decompress'
and 'de-tar' the files once they have been transferred. The program that did the compilation or the 
compression may be specific to one particular type of computer.

You should be able to find (by FTP) programs for PCs that will de-compress and de-tar the files for you.

There's more information on filetypes and file suffices in the FTP section of the Turnpike Connect book.

· Forms of file transfer 

Two forms of transfer are used:

· Binary transfer gives you a simple bit-by-bit copy of the source file. This is the type to use where you 
are copying a program 

· ASCII transfer copies the file character-by-character, allowing for the difference in the codes used to 
represent different characters on the two machines. 

You must use the correct form of transfer for the type of file you are copying.

Use ASCII if the file you want to transfer contains text, or when you are transferring a UUencoded file 
(a mixture of text and data encoded as text).

If a file has been compressed, transfer as a binary file. This will usually apply with program files.

· FTP Netiquette



FTP demands considerable resources from the source computer. It is FTP 'netiquette' that you transfer 
files at times when the remote computer isn't being used for real work ie. outside working hours at the 
remote computer. Some computer systems only allow Anonymous FTP between certain times.

The computer you are accessing may be in a different time zone to you. California, for example, is eight 
hours behind the UK, so while midnight may seem late enough in the UK, it is only 4 o'clock in the 
afternoon in California, well within working hours there.

Related Topics 
FTP



      
File Menu: Merge databases
When you upgrade Turnpike from one version to another,
you would normally replace data in the old version with 
the new data. If for any reason you put the new version in
a different directory you will not be able see the data in 
your old mailbase.

This facility enables you to Merge your current database 
with any other database you may have.



      
File Menu: Mouse
The Mouse options dialog enables you to use either the Windows 3.1/95 
scheme or the Windows 98 scheme for the function of the mouse.

Windows 3.1 and Windows 95 scheme.
Both option boxes clear. Single click the mouse to select an item and double
click to open it.

Windows 98 scheme.
Both option boxes checked. To select an item point at it (hover over it). To 
open the selected item single click the mouse.

 
When you select to highlight items using the system colours, and you hover 
to select items eg in the call costs log, the default colours will be used. Any 
custom colours you have set will be ignored.



      
File Menu: Print Preview 
When you select this option, the screen displays the current page as it will 
appear in print. Dialog    buttons provide the following facilities:

Print Prints the display that you are currently 
previewing

Next Page / Prev Page Enables you to step page-by-page through the 
display you are previewing

One Page / Two Page Switches between a Single-page and a Two-
page view. This is only available at the lowest 
zoom level

Zoom In / Zoom Out Enables you to enlarge or reduce the display
Close Closes the Preview display



File Paths dialog

The File Paths dialog is displayed by clicking the Paths button within the Sign-on dialog.

This dialog lists the location of:

· Your personal Turnpike files (the Server path)
· The Mail received and sent from your machine (the Email path)
· Usenet News copied to your system (the News path)

If you find that any of the above items have been moved, click the adjacent Browse button. Use the File 
Selector to pick out the new location for these files.

Start by selecting the Server path; the other two paths will then automatically change to match.

Related Topics
Setting where mail and news is stored
Moving Turnpike to another machine/system
Sign-on dialog



      
File Selectors
Several actions within Turnpike require you to select a file or a 
directory to work with.

In each case, Turnpike offers a standard Windows File Selector 
dialog for you to use to select the file or path that is required. This 
dialog will be automatically setup to show what is needed in its title 
and, where appropriate, to select files with the required filetype 
extension. You also have the option of setting the list of files to All 
files when required.

Use the right-hand file selector to set the directory, then the left-hand 
file selector to select the specific file or path that's required.



File menu

Rebuild database

Merge databases

Print...
Print Preview
Print Setup
Print Font...

Mouse

Exit 

Close



      
File menu: Close
Closes the on-line function you're currently using 
(FTP, Telnet, Finger, Ping or Traceroute).



      
File menu: Exit
Exits from Turnpike Connect.



      
File menu: Print
When you select the Print option from the File menu, the standard 
Windows Print dialog    appears. Use this when you want to print a 
message or an article. The main features of the dialog are:

Printer This entry shows your current printer. If you want to 
use a different printer, click the Setup button.

Print Range Use this option to set the number of pages or the 
whole message/article.
You can find out how a message or article divides into
pages by previewing it.

Setup Click this button to check or change the printer or 
paper you will use.

Copies Set the number of copies you want.

Quick keystroke: Ctrl + P



      
File menu: Print Font
This dialog enables you select the combination of font, font size 
and font style used either when printing or when displaying text 
on the screen. This dialog is also called by selecting the Font 
option from an Options menu.
Simply select the Font, then the Style and Size of the font from 
the set of three lists in the dialog. The dialog also includes a 
sample piece of text so that you can see the effect of the 
selection you've made.



      
File menu: Print Setup

This dialog enables you set the printer and paper used to print. The main 
features of the dialog are:
Printer Select either your Default printer or a specific printer as you 

require.
Paper Select the size and source from the drop-down lists.
Orientation Select either Portrait or Landscape as required.
Options Click this button to call up a further dialog in which you can 

set more advanced features such as printing to a file and 
duplex printing.



      
File menu: Rebuild database
With Rebuild Files permission this option enables you to 
recover disk space by creating a new version of the 
mailbase, newsbase or address book You can also use 
this facility to recover corrupted databases. For further 
information see; Rebuilding your mailbase etc



Fingering people or computers

The Finger feature enables you to check whether a particular person accesses the Internet via a given 
host and to find out their login name on that system - assuming that there's a Finger server on their host. 
(If there isn't a Finger server, you won't get any reply.)

It can also be used to find out who is currently logged on at a particular host and to examine the contents 
of a user's 'Project' and/or 'Plan' file. (These files are principally intended to be used for a summary of 
what the user is working on but they are sometimes used for such things as weather reports and football 
scores.)

· To find out who is currently logged on to a particular host:
1. Click on the Finger button.
2. Enter the  Domain name for this host in the dialog that's displayed. Enter the domain name in full, even 

where you are fingering one of your Access Provider's sites.
3. Click the Connect button.

· To find out specific information:
Proceed as above but enter the appropriate email address in the dialog that is displayed.

Turnpike remembers previous addresses that you have fingered. When you want to finger one of these 
again, simply pull down the list of addresses from the Finger slot of the dialog and select the address you 
want.

If a Finger button is not shown on your toolbar, it is easy to add one -- refer to Toolbar Configuration.



Full Name dialog

When you first run Connect, a message may be displayed asking for your full name, so that this can be 
included in messages.

Simply fill in the name you want Turnpike to use.

This name can be changed later by selecting the Configure option from the File menu in  the main 
Turnpike program, then selecting Users from the sub-menu that appears.

For further information, call up Help from the main Turnpike program and search for Full name, or turn
to the section on Giving yourself a different sign-on name or password in the 'Set-Up' book.



Function menu

Mail/News
Connect/Disconnect

Telnet
Finger
Ping
Traceroute

Call costs

WWW
WS-FTP



      
Function Menu: Call costs
Opens a window to setup or view the Call costs records.

Alternatively click the Call Costs button on the toolbar

The Call costs logging system enables you to keep records of 
the time and money you spend whilst on line. It provides 
detailed logs, summaries and subtotals.



      
Function menu: Connect/Disconnect
Select to connect to / disconnect from your Access 
Provider.

Alternatively click the button with telephone icon on
the main connect display.

See Mail and News Services.



      
Function menu: Finger
Opens a window through which you can 'finger' 
other sites to see details of users at that site and 
other information available to read.

Alternatively click the Finger button on the toolbar.



      
Function menu: Mail/News
Calls up the main Turnpike program so that you 
can, for example, see what mail messages have 
arrived, prepare further messages to send etc.

Alternatively click the Mail/News button on the 
toolbar.



      
Function menu: Ping
Opens a window through which you can ping other 
sites in order to see whether you can get a 
response from them.

Alternatively click the Ping button on the toolbar.



      
Function menu: Telnet
Opens a window through which you can log in to a 
remote computer e.g. to search a database held 
there.

Alternatively click theTelnet button on the toolbar.



      
Function menu: Traceroute
Opens a dialog through which you can find out 
about the route currently being taken between your
computer and a given Internet address.

Alternatively click theTraceroute button on the 
toolbar.



      
Function menu: WS-FTP
Opens a window through which you can link to 
other sites in order to copy files from them.

Alternatively click the FTP. button on the toolbar.



      
Function menu: WWW
Calls up the Microsoft Internet Explorer program 
for you to browse the World Wide Web.

Alternatively click the WWW button on the toolbar.



Gateways
A gateway is a site on the Internet through which access is 
made to the Internet. Your Access Provider will either advise 
you directly of the addresses of the gateways you will use or 
they will be provided through the standard script for this Access
Provider, in which case the information may be shown as 
Automatic.



      
Group Mail

'Group mail' is based on 'group email names . Mail that arrives addressed to one of 
these group email names appears in the mailbox of everyone in the group - but 
disappears again from everyone else's mailbox the moment someone processes it so 
there is no duplication of effort.

Group email names are simply email names with several users rather than just one. 
Within a company, you might well have names like 'sales' and 'support' setup as group 
email names with the members of your Sales team as users of the sales email name 
and the members of your Support department as users of the support email name.

  Group mail is setup in the main Turnpike program.

For further information, turn to the section on Email names in either the Set-Up 
book or the Mail&News book.



Help Menu

Index.
Using Help 
Show Hints & Tips 
About Turnpike Connect

Related Topics
Using Turnpike Connect Help



      
Help menu: Index

Calls up the Contents, Index or Find 
page of Help. The page that appears 
will be the last page you accessed.



      
Help menu: About Turnpike Connect

This display gives brief details about the 
version of the Turnpike program you are using. 
Details given include the version number, the 
date of issue and whether your copy has been 
registered.



      
Help menu: Show Hints & Tips

Click this option to show a sequence of useful tips about 
using Turnpike. From the initial screen you can select to 
show the next tip in sequence. A check box enables you 
to select for the system to show the next tip each time 
you load Turnpike or to disable this facility.



      
Help Menu: Using Help

The Help Topics dialog is displayed with 
Contents, Index and Find tabs.

The active tab will be the one you last used.



Hex Number
A hex number is simply a number expressed in 
Base 16 (rather than the normal Base 10) with 
the digits 0...9 representing 0...9 and the letters 
A...F representing 10...15.    The number is 
usually followed with an h to indicate its a hex 
number.



Host configuration dialog

This dialog is called by selecting Host from the Configure menu.

The data in this dialog is automatically filled in for you from the script provided by your Access Provider. 
Information may also include that set by you when the Access Provider was first selected. 

This dialog enables you to confirm the settings made and when necessary to change them. If you are in 
any doubt about any setting, you should contact your Access Provider.

    It should not be necessary to change any of the information given in this dialog.

Domain Name: as written after the @ in your email address

This machine: the address of your specific machine. This will be the same as the domain name 
except on a networked system

Organisation: the name of the organisation represented by users of the system. For example a 
company name or trading name, an individual's name or possibly a nickname by which you want to be 
known.

Local email: the domain over which mail can be sent without connecting to your Access Provider - 
normally the local domain represented by your domain name.

Accept email for: the domain(s) on the Internet for which mail will be accepted by this host. This will 
normally be the domain name shown above, but you may have a requirement to accept mail 
addressed to other domains.

It is a requirement of the Internet that mail is rejected if not properly intended for a site.

Allow mailbox/newsstands to use other domain names: clearing this check box will stop anyone 
personalising the domain name in messages sent from this system.

Allow mailbox/newsstands to use other organisation text: clearing this check box will stop anyone
personalising the organisation details quoted in messages sent from this system. 

Related Topics
Domains and Hostnames
Configuring Turnpike Connect



I/O Address
A port (or other device)'s Address is its location within your computer's Input/Output address 
space, expressed as a hex number.

You can get this information by calling up the Control Panel, double-clicking on System, 
selecting the Device Manager and then examining the properties of the COM ports that are 
listed. (Or you can try seeing whether this information is given in the books supplied with your 
PC and any plug-in cards you've added.)

When you select any of the standard Com1...Com4 options, the Address is automatically set 
to the default address for this port in Windows (displayed in the Address slot). If the port to 
which your modem is attached has a different address, you need to select the Other option 
then enter the required address in the Address slot alongside.

The form in which this address needs to be entered can be seen from the addresses shown in
this slot when Com1... Com4 are selected.

If a range of addresses are given for a port e.g. 02F8h-02FFh, just quote the one at the 
bottom of the range i.e. 2F8.



IP addresses
IP addresses take the form of four-part 'dotted 
quad' numbers. You will either have been given 
your own IP address when you registered on the 
Internet or had this set for you (in which case it 
may be shown as 'Automatic').



IRQ
A port or other device's IRQ or 'Interrupt Request code' is a number between 0 and 15 
which is used to label the data and instructions that are intended for that particular port 
or device.

The Com1 and Com2 serial ports conventionally use IRQs 4 and 3 respectively. 
Unfortunately, so do Com3 and Com4.

To avoid conflicts, each port or device that's in use has to have a different IRQ. So if 
you find yourself wanting to use Com1 and Com3 together, you either need to change 
one of their IRQ numbers or arrange to use (say) Com2 and Com3 instead.



      
Idle timeout

The Idle timeout period is set in the Connect to the Internet dialog. This is the length of time
(in seconds) that Turnpike will wait for a response. The default setting is two minutes (120). 

If you find that typically you have to wait longer than two minutes for a response, feel free to 
increase the time. If you do increase the time, you may then find that you are then cut off 
when you've exceeded your Access Provider's standard waiting time. 

For Demon users the waiting time before disconnection is set to two minutes longer than the 
Idle timeout set .

If no response is received after the idle time, Turnpike will display a message giving you the 
choice of timing out in 20 seconds or waiting for a further period of idle time.

If you set the idle timeout to 0 the timeout message will be disabled and the Demon 
disconnection time will be 10 minutes (600s).



Initial Setup - Answer is Blank
You must give an answer to this question.



Installing a New Access Provider

To install a new Access Provider you will need to install the appropriate ‘script’ and record details of the 
account you have with this Provider.

If you have just taken out an account with a new Access Provider you will have to install a new script. 
This will be necessary whether you use Turnpike to dial up this Access Provider or not.

When you select the new Access Provider in the procedure below, the script file is used to automatically 
complete the required dialog box entries.

If the Access Provider you require isn't included in the Select Access Provider list, replace the 
ACCESS.TPK file on your system with the latest version, and then try again. You can copy the latest file 
from the following ftp site.

ftp://ftp.demon.co.uk/pub/mirrors/turnpike/

If the script for you Access provider is not listed you can record the basic information Turnpike needs to 
know about your Access Provider by selecting the - Unknown Access Provider - option offered in the 
Select Access Provider dialog;.

Information that allows Access providers to tell us about their systems and procedures so that the access 
scripts can be produced is given in the Scripts.txt file included in the above directory. Though possibly of 
interest to individual users, it is not particularly aimed at them! 

· To install a New Access Provider:

1. Click the New button in the Connect to Internet dialog. The Internet Access Provider dialog 
appears showing the current provider; 

2. Click the down arrow and select the Access Provider you want from the list;
3. If the Access Provider is not listed, click the More button and select a name from the Select 

Access Provider dialog;
4. Click the Continue button to proceed;
5. When you have selected the Access Provider you want to install, click OK to confirm. A sequence 

of configuration question boxes will then appear;
6. Answer each question or press Esc;
7. Check the settings in the New Connection dialog and when you are satisfied that your settings are

correct click the Save button.

Your copy of Turnpike is now configured to work with your new Access Provider. Before dialling, you may 
wish to confirm the configuration of the system is as you require. Click the browse buttons to see the 
relevant Help screens or refer to the Setup manual

If later, you want to edit the details of a connection, click the Edit button on the Connect to |nternet dialog.

The New Connection and the Edit Connection dialogs only differ in title

Related Topics 
New Connection 
Connect to |nternet 



Installing your modem

You are able to install your modem from the windows control panel or by selecting the Install Modem 
button on the New Connection and    Edit Connection dialog. Either method invokes the Install a Modem 
Wizard 

1. Confirm that your modem is connected to your PC.
2. From the Windows 95 Start Menu, select Settings.
3. Select Control Panel.
4. Double-click on the Modems icon, the Modem Properties dialog will appear.
5. Click the Add button and the Install a Modem Wizard will appear.

As stated above the same Wizard will appear when you click the Install Modem button on the Edit 
Connection dialog.

6. Ensure that the tick box by the Don't detect option is cleared.

7. Click Next. 
If you see a display asking you "What type of modem do you want to install"
select either PCMCIA modem card, if you have one, otherwise select other 

The above screen is only displayed where relevant

8 Click Next. Windows will attempt to identify your modem.
· If your modem is correctly identified, simply click the Next button.
· If the modem    isn't correctly identified, click the Change button and select the modem's 

manufacturer and model from the list displayed.
· If your modem isn't listed and a disk was supplied with the modem, select the Have disk option

Or, select the Standard modem of the appropriate baud rate - from the top of the Manufacturer's 
list.

9. Click the Next button.

10. Confirm the modem port is set correctly. If you are installing a modem for the first time, enter details 
of your location and your phone system.

11. Click the Finish button.

· Setting Modem Properties
a) Confirm that you have your modem connected to your PC.
b) Select the My Computer icon 
c) Right-click on the dial-up icon for the connection you are using and choose Properties from the 

drop down menu
d) Check that the information stated on the General page is correct
e) Click the Configure button

· General Properties 

Speaker volume.    To suit local conditions.



Maximum Speed.  The speed to set will depend on the modem and the type of UART in the COM
port. How fast your PC is able to respond also has an effect.    
· If the COM port uses a 16550 UART set the maximum speed to 38400,
· If it uses an 8250 UART, set the speed to 19200.

If you don't know what type of UART is used, you can find out by returning to the Modem 
Properties dialog, switching to the Diagnostics display, selecting the appropriate port and clicking
the More info button.

· Connection properties

1. Click on the Connection tab.

Connection preferences: The default settings are Data bits 8, Parity None, Stop bits 1.

Call preferences: 
Wait for dial tone Select this option if your modem is able to detect the dial tone. 
Cancel the call if not connected within. Set to 60 secs or as you require.
Disconnect a call if idle more than. Set to 30 secs or as you require.

2. Click the Advanced button. The Advanced Connection Settings dialog will appear.

Use error control: This is automatically selected where it is supported by your modem.
Use flow control: Select Hardware flow control.
Modulation type: Select the Standard setting.
Extra settings: These may be required if Windows 95 didn't recognise your modem.
Record a log file: Check this option is you want a record of the DUN modem initialisation, 

dialling etc.

3. When you have completed setting your modem's properties, click OK/Close to save the 
properties you have set.

Related Topics
Which modem to pick
COM Ports



Internet Access Provider dialog

This dialog is displayed when you select:

· New from the Access Provider dialog or Connect to Internet dialog;
· or New or Alter from the Access Provider dialog.

The Connect to Internet dialog appears when you first logon to Connect and when you click the 
Connect button on the Main Connect display.

The Access Provider dialog is displayed when you select Service Access from the Configure menu.

For further details refer to related topics below.

Related Topics
Access Provider dialog
Connect to Internet dialog
Main connect display



Internet information services

The Internet offers a wide range of other information services, such as:
· Gopher - helps you to locate information through a series of menus.
· WAIS - enables you to search for articles on different topics by keyword.
· Archie - can tell you where particular files are available by Anonymous FTP.

Turnpike does not support these services directly but you can access them through the Web Browser. It is
also possible to run Winsock-compliant clients for them alongside Turnpike, using Turnpike's Winsock. 
Such software is freely available on the Internet.

The other way of accessing these services is to telnet to a host which offers an appropriate client program
- but don't expect the response time to be quick.



Keyboard layout choice (in Telnet)

It is generally easier to follow the instructions you receive from the remote computer if the numeric keypad
on your keyboard is set to mimic the numeric keypad on a DEC keyboard. This keyboard includes four 
programmable function keys PF1 - PF4 on the top row of this keypad.

So Turnpike automatically selects this 'DEC layout' for your numeric keypad whenever your PC emulates 
a DEC terminal, but you can opt for the keypad keys to have their normal 'PC layout' if you prefer. (Then 
function keys F5 - F8 take on the role of PF1 - PF4.)

Alternatively, you can take the Keyboard option from the Options menu, then set the layout you require 
in the VT keyboard layout area of the dialog that's shown. The main purpose of this dialog is to enable 
you to setup the function keys to issue commands for you.

Related Topics
Telnet Function Keys
DEC/PC layouts
Defining function keys
Introduction to telnet



Kill Rules
Kill rules are specifications for types of articles that you don't wish to have 
downloaded in full.

The rules are setup through the Kill option offered in the main Turnpike 
program. Each rule just applies to the newsgroup in which it was created, 
giving rise to different sets of rules for each newsgroup.

When Turnpike is downloading articles from a newsgroup, it will only 
download the headers of those articles that are picked out by the 
corresponding set of kill rules.



Leaving Turnpike Connect

To leave the Connect program, simply take the Exit option from the File menu.



Logging

Select this option from the Window menu to display the log file.

Alternatively click the Log Window button on the main Connect display.

If you want to record the commands and responses given while you are using any of the On-line services,
select the Log option from the Snapshot menu, then select either Log entire session or Log from here 
as required.

The various commands and responses will then be saved in a log file (which you pick out through a File 
Selector).

When you've logged as much as you want, select the same Log option but this time select Stop logging.



Login name / Hostname
The name which you (or your site) is known to your Access Provider. This name will be 
used to identify your site when you connect to the Internet. You should only need to 
change the name recorded in this dialog if your Access Provider allocates you a new 
one.

Your login name is not usually regarded as confidential and so is shown in clear in this 
menu, but the password that's given alongside the login name is confidential and is 
therefore shown as asterisks.



Mail and News Service Indications

· Off line Mail and News Service indications

By default all services are active as soon as you click the Connect button on the Connect to 
Internet dialog.

To enable a service, click the Start button. The text in the service area changes from disabled to 
enabled. The legend on the adjacent buttons indicates Disable. When a service is offline the 
background colour is white.

Expiring Newsgroups initially indicates the number expired and the total. The legend on the button 
indicates Stop. When expiring is complete the legend on the button changes to disable and the text 
shows the time finished and the number of items expired.

· On-line Mail and New Service indications
The back ground colour of each service indicates the current state as follows:

Grey: disabled
Dark blue: enabled
Yellow: waiting for an enabled action to start
Green: active - sending or receiving mail or news
Red: error. If this occurs, click the Logging button to determine the cause of error

These colours are as initially installed. If you want to change the font or the colours used, click the
options menu.

Posting News When complete the text indicates Posting news complete at 15:45 (typical). The 
legend on the button indicates Stop.

News Collection enabled changes to Collecting news at 13742 cps    49% complete ( typical). The
number of items collected so far and the number still to be collected are also shown. When complete 
the text indicates News collection complete at 15:37 (typical). The legend on the button indicates 
Stop until collection is complete when it changes to Disable.

The number of articles to be downloaded won't necessarily match the number of new articles that 
appear to be read in your newsgroups. 

If you want to see what is being downloaded click Window in the menu and then click News 
Client.

If you close the main connect window when you are connected, and active, the download will 
stop. However, you may minimise this window.

Stay connected to your Access Provider - at least until the message News collection 
closed - filing continues appears.

Stay in the Connect program until the message News completed, xxxx articles fetched 
and filed message appears. If you do not stay in the connect program the list won't be filed 



correctly and will have to be collected again the next time you connect to your Access 
Provider.

There’s no need to wait for all news to be filed before you click the Disconnect button. 
However, you must wait for filing to be completed before you exit the Connect 
program.

When all the mail and news has been collected and you have completed any other on-line actions, click 
on the Disconnect button.

For offline activities click the Mail/News button. For further details refer to Help in the Main Turnpike
program.

Related Topics
The Main Connect Display
Sending and Receiving mail
Configure Email Send and Receive dialog
Collecting News
Configure Newsnet News dialog
Errors and overruns



Mailing Lists

Mailing lists do a similar job to newsgroups in that they provide people with special interests with a way of 
sending a message to everyone that shares that interest. Indeed, some Mailing lists double as 
newsgroups so that everything that's sent to the newsgroup is also sent to the Mailing list and vice versa.

The main difference between Newsgroups and Mailing lists is that Mailing Lists contact people via the 
Internet Mail system, rather than via the News feed. Indeed, the reason for having Mailing lists as well as 
newsgroups is that not everyone on the Internet has access to the newsgroups. In particular, people who 
don't use the Internet directly but instead log on to a network that has a gateway to the Internet may not 
have access to the News feed.

To join or to leave a particular mailing list, you need to send a message to the list's administrator, telling 
him/her that you want to subscribe to or unsubscribe from their list. The standard way of doing this is by 
sending the appropriate email message to the mailing list's administrator. The messages from the mailing 
list will then be delivered to you in amongst the other mail you receive.

If you have List Subscribe permission, you can get Turnpike to prepare and send these messages for you.
Turnpike also arranges that the mail you receive from the mailing lists you subscribe to is handled within a
special newsgroup, rather than mixed in with other mail. This is not only to keep items of mail from the 
mailing list separate from your other mail, but to also arrange to thread items that follow on from each 
other and to expire old items after a set time.

These changes are made in the main Turnpike program.
Related Topics
Mailing Lists in the Set-up book
The Turnpike Mail & News book
From Turnpike Help, select Mailing Lists



The Main Connect Display 

The main Connect display comprises:
· The menu bar
· The toolbar with control buttons
· Mail and news and mail service indications and controls

The Mail and News Services indications and controls occupy the main area of the Main Connect display 
under the toolbar. In the upper left of this area is a button with a telephone icon.

When offline, the telephone icon has a green up-arrow and is labelled Connect. When you are online, 
the icon has a red down-arrow and is labelled Disconnect.

Adjacent to the connect button are the following General Indications:
· Text states if you are connected or disconnected
· The name of the Access Provider you have selected
· The user name
· The auto-diconnect time This indication appears if there is no activity after repeated redials (time

expired)
· When connected, incrementing counters indicate the period of time you have been on-line and 

the cost.
· When you have completed online activity and you press the Disconnect button, data in the upper 

right of the screen indicates:
· the number of items sent and received
· the rate at which data was transferred in characters per second (cps)
· and the number of reporting errors (overruns) in this transmission

When you click the Log Window, in the upper right of the window a connection activity file is 
displayed.

When you click the Details button on the right of the display the Mail and News Service indications 
are displayed. If you click this button again these indications will close.

Related Topics
Connect to Internet Dialog
Mail and News Service indications
Errors and overruns



Main Menus

File
Edit
Configure
Functions
Options
Snapshot
Window
Help



Making a New Connection

In addition to installing additional Access Providers you are also able to make as many connections as 
you like to each Access Provider you use, each using a different modem if you wish. The default 
Connection name in the associated dialogs is the same as the Access Provider. When you use more than
one connection you must change this default to a name you recognise. 

You can make a new Connection from the Connect to Internet dialog or from the Access Provider dialog.

· To make a new connection
1. Click the New button on the Connect to Internet dialog. 
2. Click the down arrow and select the Access Provider you want to use or just click OK.
3. Enter a new name for the Connection in the New Connection dialog and change other details 

required for this connection.

The case of the name is ignored. The name entered must be unique.

4. Click OK to save. 

If you want to change information for an existing connection click the Edit button.

Related Topics
Configure Service Access
Edit Connection dialog
New Connection dialog
Connect to Internet dialog
Which modem to pick 
Connection settings



Merge Databases

When you upgrade Turnpike from one version to another, you would normally replace data in the old 
version with the new data.

If for any reason you put the new version in a different directory you will not be able see the data in your 
old mailbase.

This facility enables you to merge your current database with any other database you may have.

· To Merge a Database
1. Click File in the menu.
2. Click merge database, the Merge database dialog appears.
3. Enter paths or click the Browse button to select the Server path and email paths of the directories

you want to merge with your current mail databases.

The following files must be included:
From the Mail directory      Mspool and Mailbase
and from the Turnpike root directory Turnpike.usr

4. Click the OK button and a dialog will appear that will quote the following three stages:
Stage 1: You may be asked for a password
Stage 2: The other database will be rebuilt
Stage 3: Messages will be merged

5. If you wish to continue click the Yes button.

If encryption has been lost you will be asked to enter a Password.

When mail is merged you will see a statement like 7 copies, 5 messages merged.
This discrepancy will occur for messages that you sent to yourself. The sent and received copy of the 
message is treated as one message.

The statement may also state that some messages have been imported. Normally messages will be 
copied to the same seat, mailbox, etc. If any of this data is not available the message will be treated 
as a new message and will be stored in accordance with the rules for the current databases.

Related Topics
Rebuilding the Mailbase etc.
Backing up your Turnpike files
Moving Turnpike to another machine or system



      
Mirror
If you are downloading mail by POP3 you can choose to mirror your email. 
This means that the contents of your mailbox on your Access Provider's 
server will match that of your Turnpike mailbox. If you leave email in a 
Turnpike mailbox, a copy will also remain on the server. If you file or delete 
the email in Turnpike or move it to the pending tray, it will be deleted from 
the server next time you connect.

This option is useful if you want to dial in and read your mail from more than
one place. 



Moderated groups
A moderated newsgroup is one in which contributions aren't posted directly
to the newsgroup but instead are initially mailed to a moderator. The 
Moderator decides whether the articles are appropriate for inclusion in the 
newsgroup. This procedure improves the quality of the contributions to the 
newsgroup and keeps the discussions on target, but at the cost of a slower
response rate.



Moving Turnpike to another machine/system

If you want to move Turnpike to another PC or upgrade to a PC with a different operating system;

 Don’t try just copying all the old files from your old system to the new one.

· You should complete the following procedure:

1. setup a new directory, for example c:\Turnpike

2. Copy the following from the old Turnpike directory to the new directory.
TURNPIKE.USR
CALLS.TPK 
NEWS directory
MAIL directory 
USERxxx directories
All ACC, .CST or .MDM files you use 

3. Use the Turnpike Setup program to install an appropriate version of Turnpike on the new 
system.

The installation program will ask you to select either a Typical, Compact or Custom installation 
and will state the directory in which Turnpike will be installed.
Installation is normally to a \Turnpike directory on which the setup program is run (step 1). If 
you want Turnpike to be installed in a different directory, use the Browse button at the bottom 
of this dialog and select the directory you require.

4. When installation has been successfully completed, run both the main Turnpike program and the
Connect program.

5. Check that each program is set up and configured as you require. For details refer to:
· the Setup book 
· In Turnpike Help Contents. Relevant topics in the Configuring Turnpike 'book'.
· In the Connect Help Contents: Relevant topics in the Configuring Connect 'book'.

Related Topics
Rebuilding data files
Backing up your Turnpike files
Merging databases
File paths dialog
Setting where Mail and News is stored



Multiple Access

The standard Turnpike software can be used by up to 99 people, but it is a 'single user' version, which 
means that you can only have one copy of Connect and one copy of Turnpike running at the same time 
(although they do not necessarily have to be on the same machine).

If you wish to install Turnpike on a LAN (Local Area Network), with a copy of the offline software on each 
workstation, run the Turnpike Setup program on your central server, choose 'custom install' and then 
select Turnpike Workstation Setup. This will place a special setup program on your central server from 
which Turnpike can be installed onto each workstation.

LAN administrators should note that mail that has been collected by Turnpike can be accessed across the
network by other mailreading software if you enable the POP3 Server option, although again only one 
person at a time can use the standard version of Turnpike.

If you require more than one person to be able to use Turnpike simultaneously, you will need a Multiple 
Access version of the program. This still uses just one copy of Connect, but allows you to have multiple 
copies of the Turnpike program running; up to the number of seats purchased. Email info@turnpike.com
for further details.



NVT
NVT stands for Network Virtual Terminal. This is a 
very simple terminal type which any remote 
computer should be able to work with.



New Connection dialog

This dialog is displayed by clicking the New button on the Connect to Internet dialog or the Access 
Provider dialog.

If you click the Edit button in the Connect to Internet dialog the Edit Connection dialog will appear. 

The details in the New and Edit dialogs are the same, the dialogs differ only in dialog name and usage. If 
you only want to Edit details of your connection, refer to the Edit Connection dialog. You can only add a 
New Access Provider if you have dialling admin permission.

· To add a New Access Provider
1. Click the New button. The Internet Access Provider dialog appears showing the current 

provider. 
2. Click the More button, the Select Access Provider dialog appears.
3. Select a new name from the list. If the Access Provider you want to use is not listed, refer to 

Installing a new access Provider script.

If you want to keep the option of dialling up using the 'old' details for this Connection, ensure you 
enter a different name in the New Connect dialog. If you do not change the Connections entry, any 
new details entered will simply replace the old ones when you click the Save button.

4. Click the Continue button.
5. Click the OK button to confirm.

6. A sequence of configuration question boxes will now appear. Answer each question or press Esc 
to escape. Full details are given with each question. Brief details are as follows:
a) To select the Mail forwarding option, click on the Yes or No button.
b) If you select Yes, accept or enter a new Domain name.
c) Accept or enter a new Hostname
d) Accept or enter a new password
e) Accept or enter Organisation

7. The New Connection dialog appears. Complete the entries as follows:
 

· Connection as set in the Access Provider dialog. 

The case of the connection name is ignored. 
The name entered must be unique

Use Turnpike dialler. If you are using Turnpike to dial the option box should be checked, see 
Dialling up from idle.

· Modem: Enter the modem you are using. To switch to a different modem, click the down arrow
and select from the drop-down list. Click the check box if you are using ISDN. If the modem 
you are using is not listed see Installing your modem.



· Access Provider as set in the Access Provider dialog.

· Point of Presence (PoP). This is where you dial to connect to your Access Provider. Click on 
the down arrow and select a name from the list - the phone number will be filled in 
automatically.

If the PoP you want is new or has changed its phone number, the number you require may not be 
included in the list of Points of Presence. If you know the new number, type the new number over 
the one currently shown in the Phone number slot. DO NOT amend the Point of Presence or the 
number you have typed will be lost. Take care to type the correct number

8. When you are satisfied with the details entered click the Save button.
9. To proceed refer to Going On-Line

Related Topics
Going On-Line
Edit Connection dialog
Installing a new Access Provider script
Access Provider dialog
Making a New Connection 
Installing your modem.
Connection settings



News Collection
Selection of this option displays the 
Configure Usesnet News   dialog.   Use this 
dialog to set where you will get Usenet 
news articles from and how news will be 
handled.



      
Newsstands
Newsstands are simply collections of newsgroups that 
each Turnpike user sets up for themselves in order to 
follow discussions on topics they are interested in. For 
more information, either see the Turnpike Mail&News 
book or call up the Help file from within the main 
Turnpike program.



Number of News Articles Downloaded
The number of articles to be downloaded won't necessarily match the 
number of new articles that appear to be read in your newsgroups. The 
counts in the newsgroups don't include articles in threads that have been 
marked 'Not interesting'; also, they don't include articles killed by kill rules.

These articles are included in the count of articles downloaded because the 
headers have been downloaded and these are included in the count. In 
addition, articles that pass the kill criteria are counted twice because the 
headers and the bodies are downloaded separately.

A further possible reason for having more articles downloaded than you are 
offered to read is that you've got rid of a newsgroup you require from a 
newsstand but not from the overall subscription list.



Options menu

This menu on the main connect screen offers the following options:-

Colour

Window Font
Window Colours

The Colour option enables you to set the default colours on the Main connect screen. The Window
Colours option enables you to set colours in the Logging, Telnet and Ping screens. 

If you use the Font or Colour options from within a function, this will make a temporary change i.e. 
it will apply for the current session only. The colours set this way will revert to the default colours for
the next session.

The following additional options are available from the Telnet Options menu:

Emulation.
Keyboard 

Related Topics
Show Toolbar
Show status bar



      
Options menu: Colour
Displays the Status Colours dialog. This dialog shows 
you the colours currently used for the Mail and News 
service areas on the main connect display.

To change a colour click the Alter button. Select the new 
colours in the Colour selection -Status colours dialog

To return all colours to the default, click the Default 
button



      
Options menu: Show Toolbar

Click this option to show or remove the 
toolbar from the main Connect display.



      
Options menu: Show status bar

Click this option to show or remove the status bar 
from the main Connect display.



      
Options menu: Windows Font
Displays the Font for Turnpike Connect dialog. Use to select 
the typeface, typesize and typestyle used to display commands
and responses on the screen.

    This option only sets the font used for the main Connect 
display. The font used when printing is set through the Print 
font option in the File menu.



POP3 Server option

The POP3 Server options included in Turnpike enable users to access the mail in their Turnpike mailbox 
from outside their Turnpike system. This can be from a copy of Turnpike running on a machine that 
doesn't have direct access to your mailbase or from another mailreader.

This is a specialist facility and is intended for use in an office where mail for everyone in the company is 
collected using Turnpike but people don't necessarily always want to use Turnpike to read their mail.

It is not intended for use on a single-machine dial-up system. To use this facility the Connect program 
must be running. Also there must be a live TCP/IP connection between the machine on which Connect is 
running and the machine from which the mailbox is accessed.

This facility will open a route whereby people from outside the company could potentially access 
users' mail.

For this reason, this facility has to be specifically enabled:

either through the 'Enable POP3 Server' option in the Configure Email send and receive dialog;

or for each individual user who is allowed to access their mailbox in this way. (By giving them 
Serve POP3 permission from the Configure Users dialog in the main Turnpike program);

The system also requires any user wishing to access their mail in this way to give their Turnpike 
sign-on password.

Ensure that any users for whom this facility is turned on do not have a blank password. If the 
password is blank it will be just too easy for someone outside the company to impersonate them.

Calling up a Turnpike mailbox from outside counts as an access to the Turnpike system. With the 
standard 'Single access' version of Turnpike, you can't call up your mailbox while anyone is using the 
main Turnpike program and vice versa. With the 'Multiple access' version, users are able to call up their
mailboxes at the same time as others use the main Turnpike program but only up to the number of 
seats on the system.

Related Topics
Configure email send and receive dialog



Passwords
Turnpike includes the option of making access to the system, and in particular to someone's personal 
mail files, dependent on giving the correct password. You will either have had this password set for 
you by your system administrator or set it yourself in the Edit Sign-on details dialog. If you forget 
your password, a new password can be set by the administrator or by anyone with Alter Users 
permission.

For security, whenever a password is typed or displayed, the screen only shows * characters.

    New Passwords are setup from the main Turnpike program.

Related Topics
Turnpike Help  Password setup
Set-Up book. - Giving yourself a different sign-on name or password.



      
Permission

Turnpike has sixteen administrative functions. Permission to use these 
functions applies generally to a multi-user system where family members 
share the same computer, or where a number of users share Turnpike on 
a network. The permissions are set through the main Turnpike program, as
part of the Configure Users and Configure Workgroups procedures. 

  Permissions are set from the main Turnpike program.

Pinging

The Ping feature enables you to test whether a particular computer on the Internet is running. This can be
very useful when troubleshooting.

· To ping a computer from Turnpike:
1. Click on the Ping button.
2. Enter the computer's Domain name in the dialog that is displayed. This needs to be given in full, 

even where you are pinging one of your Access Provider's sites.
3. Click the Ping! button.

If you don't get a response, possible reasons may be:

· The remote computer is switched off
· Something within either the Internet itself or your connection to the Internet (i.e. your phone link or 

your Access Provider) is not working
· You're not giving the correct machine name.

Turnpike remembers addresses of previous sites you have pinged. When you want to ping one of 
these again, select it from the pull down list in the dialog.

If you are using Ping to discover where a problem lies, use the computer's dotted-quad IP address if 
possible in place of its domain name. Then the test you make won't involve the Domain Name 
Server.

Your Access Provider should be able to help you if you do not know the domain name or IP address 
for pinging.

If a Ping button is not shown on your toolbar, it is easy to add one -- refer to Toolbar Configuration



"A serious problem has occurred in the Connect program"

When this message is displayed, the Turnpike program has encountered a situation where it was about to
terminate with a General Protection Fault.

Instead of terminating, Turnpike writes a report file in your Turnpike directory, which contains diagnostic 
information. You are advised to note the events leading up to the problem in the description box; this may 
help us to solve your problem.

Email the file to: PROBLEMT.TXT to problems@turnpike.com for investigation.

In some circumstances, you can choose to Continue the program. If this does not cause the problem 
dialog to reappear, you are advised to close down and restart anyway at the first convenient opportunity.

If it was not possible to continue, or the problem occurs again, press Terminate. You may in this case 
need to rebuild the databases the next time you run Connect, if prompted to do so.

Related Topics 
Troubleshooting



Progress Dialog

A progress dialog is shown whenever Turnpike 'Connect' starts an operation that will take more than a 
few seconds to complete. To give you an estimate of how long it will take the progress is shown in terms 
of a count or percentage.

You can Cancel the operation if you wish, but usually you would then have to start it again from the 
beginning.



ALERT: Abandoned configuration
You will need to re-run Turnpike Connect and complete this initial configuration before you can use any of 
the Connect program's facilities.



ALERT: Access denied
The action you are trying to take is contrary to the access that's allowed to the object you are trying to 
process. You may, for example, be trying to write to a read-only file or to open a directory as a file.

You probably need to select a different filename.



      
Alert : Area code not set.
You have not entered an area code. Click the No button 
and check that an Area Code is entered in the Dialling 
Properties dialog. For further help, refer to Connection 
Settings.



      
Alert: Article requests
This message is for advice only, click OK to 
continue.
For further help refer to Article Requests



ALERT: Auto-Wrap
The Auto-wrap column number must be set to a value between 10 and 200.



ALERT: Bad signature
Either you've tried to combine files from different versions or from different users, or this file has become 
corrupted.

Make a back-up of the important files in your system - separate from any previous back-up you've taken - 
then try to sort the problem out, for example by restoring files from a previous back-up or, if a datafile has 
been corrupted, by rebuilding the affected file.



ALERT: COM Port problem
Check the COM Port settings in the Dial Settings dialog (or Modem setup Wizard) against the ones in the 
Windows Control Panel and the MSD report.

There's a mismatch somewhere.



Alert: Call costs Summarize
Answering yes will make a permanent change to your records. However, providing you haven't closed the
Call costs window, you could still abandon this action later by selecting Revert from the Edit menu.



Alert: Call subtotal duplicate
You cannot enter a date which is already in the list or 
which is before the date at which your detailed call 
records currently begin.



Alert: Can't Change list of Article Requests
Wait for news collection to complete or disconnect, request the articles you want and then connect again



ALERT: Can't rebuild
You need to ensure that all copies of the Turnpike program are shut before you can re-build this datafile.



ALERT: Cannot run application
There is a problem with the application that you are trying to run.

Check that the path details are correct and that this application is correctly installed.



Alert: Clock Wrong
Set the time and date by going to the Windows Control Panel and selecting the Time/date option.



Alert: Configure News Server.
This is advice only, click OK to continue. 

For further help refer to Configure News Server dialog.



Alert: Connect is still active

Click OK then click the Disconnect button on the main Connect display and then shutdown the Connect 
program again.

If you close the main Connect window while active the download will stop.

Stay connected to your Access Provider at least until the message News collection closed - 
filing continues appears.

Stay in the Connect program until the message News completed, xxxx articles fetched and filed 
message appears. If you do not stay in the connect program the list won't be filed correctly and will 
have to be collected again the next time you connect to your Access Provider.

There’s no need to wait for all news to be filed before you click the Disconnect button. However you 
must wait for filing to be complete before you exit the Connect program.

When all the mail and news has been collected and you have completed any other on-line actions 
click on the Disconnect button.



Alert: Connection Name
The name entered must be unique. The case of the connection name is ignored. For futher details refer to
Making a New Connection



ALERT: Contact Support
Either email info@turnpike.com or phone Turnpike Support on 0845 272-2666* with details of your 
Site ID (which you can find out by editing the CONNECT.INI file in your Turnpike directory).

* Calls to 0845 272-2666 may be monitored for training purposes. This information may be used for marketing purposes.



ALERT: Continue ?
Click the Yes button to cancel or the No button to continue without cancelling.



ALERT: Correct Secret/Password
The mailbase is about to be re-encrypted and rebuilt.

Your Address book will also be rebuilt. If the ADDRBOOK file in your mail directory comes from the same 
system as the mailbase, the new Address book will naturally contain address etc. information taken from 
that mailbase. But the rebuild won't add these addresses to the Address Book from your current system.

If you want these addresses in an Address Book and you don't have the 'original' ADDRBOOK file, 'hide' 
your current Address book either by renaming it or by moving it to another directory. Turnpike will then 
build a fresh Address book from the information in the mailbase which you can subsequently combine 
with your current Address book by exporting the addresses from either this or your original Address book, 
then importing these addresses into the other Address book. For further information on this operation, call
up the Help file within the main Turnpike program and look for information on Importing / Exporting 
addresses.



ALERT: Corrupt datafiles
The datafile(s) needs to be rebuilt. To rebuild the files, either the System administrator or another user 
with Rebuild files permission needs to take the Rebuild database option from the File menu and follow 
the instructions on the screen.

Rebuilding these files may take some time.



ALERT: Corrupt or damaged program files
This file has either been deleted or it has become damaged in some way.

You probably need to reinstall Turnpike.



Alert: Credit Card
You must enter wether you are using a Company or Personnal credit card.

Click OK to continue



ALERT: DOS error
This is a system-level problem.

For a detailed explanation, look up the error message in the information on 'DOS errors' or 'System errors'
(or just 'Errors') in the documentation supplied with your machine or with the operating system you are 
using.



ALERT: Database files missing
The chances are your mail/news files have been moved but this move hasn't been recorded in the File 
Paths dialog.

To sort this out, click OK: then back in the Sign-on dialog, click the Paths button to display the File Paths 
dialog and check that the correct directories are selected.

If necessary, use the Windows File Manager / Explorer to check the location of:

Your TURNPIKE.USR file (the Server path - probably a TURNPIKE directory)
Your MAILBASE, MSPOOL and ADDRBOOK files (the Email path - probably a MAIL directory)
Your NEWSBASE and NSPOOL files (the News path - probably a NEWS directory)



ALERT: Delete original?
Turnpike has kept the previous version of this file (suitably renamed) in case you added any special 
features to it which you want to copy over into the new file.

If you didn't change the previous version or the change you made is no longer needed, click the Delete 
original button. There's no point keeping the earlier version of a file unless it contains special information 
you need to copy to the new file.



ALERT: Demon already
You have already setup a Demon Internet account.    It is probably a mistake to setup another. You should 
use the existing account.



ALERT: Demon only
The Trial version of Turnpike you are using can only be used in conjunction with a Demon account.

If you have a Demon account, take Service Access from the Configure menu and use the Access 
Provider dialog that is displayed to select your Demon account.

If you don't have a Demon account and you want to continue using Turnpike, you will need to buy a full 
copy of Turnpike. For further information, contact Demon Sales on 0845 272-2666*

* Calls to 0845 272-2666 are monitored for training purposes. This information may be used for marketing purposes.



ALERT: Device Driver problem
To correct this problem, you need to leave not just the current program but any other applications that you
are currently running and edit your SYSTEM.INI file - which you will find in your C:\WINDOWS directory.

When this file is displayed, find the section headed [386Enh] and check that this contains four device= 
lines as follows:

device=c:\turnpike\ntstim.386
device=c:\turnpike\ntsakr.386
device=c:\turnpike\vtcprac.386
device=c:\turnpike\ntspsd.386

Any duplicates or other variants of these lines should be deleted.

Save your changes, then restart Windows and run the Connect program included in the Turnpike 
folder/program group.

These instructions assume you installed Turnpike in the root of your C: drive. If you installed it somewhere
else, you will need modify these device= lines accordingly.



      
Alert : Different Country set.

You appear to be attempting to dial from a different 
country. Click the No button and check that the correct 
country is selected in the Dialling Properities dialog. 

If you are sure the country you set is correct click the 
Yes button to continue. 

for further help refer to Connection Settings



ALERT: Different encryption
The mailbase you've picked out to use has come from an earlier version of Turnpike which either had a 
different Site ID or used a different Site Secret.

To use this mailbase within your current Turnpike system, update the system the mailbase comes from to 
the current version. Then select the mailbase within that updated system. Once you have done that, the 
Turnpike you're currently using will initially see it as an invalid file but should then be able to re-encrypt 
and rebuild it.



ALERT: Disconnect ?

If you click Yes Turnpike will close all the open clients and then disconnect.

Click No if you want to check that you've really finished with these clients before disconnecting.



ALERT: Disk full
You are strongly recommended to switch to the Windows File Manager / Explorer and make some space 
available on the drive named in the message. Having made space, you should then return to the 
message and click the Retry button.

Doing anything else is not recommended.



ALERT: Disk problem
This is a disk/drive problem.

If it's obvious to you what you need to do to correct the problem, look up the error message in the 
information on 'DOS errors' or 'System errors' (or just 'Errors') in the documentation supplied with your 
machine or with the operating system you are using.



Alert: Edit Requested Articles List.

If you want to cancel the changes you have made to the list of requested articles - Click Yes
To accept the changes - Click No

For further help see Article Requests



ALERT: Failed rebuild
There is a serious problem with this database. You probably need to replace it with your back-up copy.

Important: Replace NEWSBASE and NSPOOL together; similarly replace ADDRBOOK, MAILBASE and 
MSPOOL together.



ALERT: File Error
This file is either missing or corrupt. You may need to reinstall Turnpike.



ALERT: File location problem
Check the file details you are giving. They are probably out of date.



ALERT: Full version
If you are doing this deliberately, fair enough - but otherwise you are missing out on a couple of features 
quite unnecessarily.

You can pick up a full version by FTP from:
       //ftp.demon.co.uk/pub/mirrors/turnpike/

The files are quite big, so different 'flavours' are offered, covering the choice of 'Windows 3.x' version (for 
16bit systems) or 'Windows 95' version (for 32bit systems), with or without Microsoft Internet Explorer. 
Study the Readme file in the directory for information on which file you need to copy.



      
Alert: Initial Setup - Select an ISP from list

Click OK, then select an ISP by clicking on the 
appropriate entry.

If you don't know which entry to select, click the 
Help button shown below the list.



ALERT:    Install Modem
You may be trying to use a modem that has been uninstalled.

If you uninstall a modem using the Windows 95 control panel, that modem will remain in Turnpikes 
memory and hence in the list of modems in the Edit Connection dialog until you select a different 
modem from the list. 

If you then try to connect using a modem that is listed but has been uninstalled, an error message dialog 
will appear. 

Select any other modem from the modems list in Edit Connection dialog then click the Save button. 
Click the Edit button on the Connect to Internet dialog again and only those modems currently available 
will be listed. 

To reinstall the modem or to install a different modem refer to Installing your Modem.

Click the OK button to continue



ALERT: Insufficient resources
You probably need to close some of the other applications you are currently running.

It may even be a good idea to restart Windows.



Alert: Internal Error
This is for advice only. Click OK and try again.



ALERT: Invalid gateway
Call up the 'Configure Email' dialog and check that the address given for the Mail gateway is correct.

If necessary, reinstall your Access Provider.



ALERT: Invalid script
The script for your current Access Provider (.ACC file) / your modem (.MDM file) has been modified in 
such a way that it no longer has the correct format.

If possible, replace it with a back-up copy of the unmodified file.



ALERT: Invalid timings
Restore the settings you changed in the Connect.ini file e.g. by going back to your back-up copy of this 
file.



ALERT: Line too long
Turnpike is unable to handle this file.

Are you sure you picked the file you meant? Are you sure it is a text file?



ALERT: Lost seat recreated
To start with, the lost seat is assigned to userxxx where xxx represents a number.

To access the files associated with this seat, the System Administrator or someone else with Configure 
Users permission needs to go into the main Turnpike program, call up the 'Configure Users' dialog and 
edit the userxxx entry to give it a suitable sign-on name and password.

The files can then be inspected by someone signing on using this sign-on name and password.



ALERT:    Mail Password dialog
The mailbase that you have asked to re-build needs to be re-encrypted in order to make its contents 
viewable from within the current Turnpike.

Before doing this, Turnpike wants to check that you are a proper person to be accessing the mail in this 
mailbase. Hence the request for either the Site Secret of the system from which the mailbase comes or 
for the password of the occupant of Seat 1 on that system (who will usually also be the system 
administrator on that system).

Without one or other of these, Turnpike won't re-encrypt and rebuild the mailbase for you (though it will 
allow you to try again if you get the Site Secret / password wrong at the first attempt).

Type either of these in the slot provided and click OK.



ALERT: Make selection
Simply pick the option you prefer.



ALERT: Modem
Enter the modem you are using in the New or Edit connection dialog.



ALERT: Modem file error
There is an error in the Modem file you are attempting to use. Uninstall the modem from the Windows 95 
control panel and then reinstall.

Click OK to continue.



ALERT: Must rebuild
First check that you are using the files you intend (i.e. that the file shown in the dialog is one you intended
to use). If it is, either take the option to rebuild this file (if this is offered) or rebuild it yourself.

If you ever replace any of your datafiles from backup copies, be sure to replace the NEWSBASE and 
NSPOOL files together and the MAILBASE, MSPOOL and ADDRBOOK files together. Don't try to 
combine files from different back-up sets.



ALERT: Network problem
Consult your system administrator.



ALERT: No Share
Turnpike needs to access an active copy of either SHARE or VSHARE.

The chances are that all you need to do to activate one of these programs is restart your machine: 
indeed, the option to re-start may be automatically offered when you click OK.

If restarting your machine doesn't make the problem go away, consult your System Administrator.



ALERT: No Tariff Info
Turnpike cannot find the information it requires to calculate call costs. You may be able to correct the 
problem by re-selecting a Carrier from Call Costs' Configure menu.



ALERT: Not an exe
The program will not run because the file you have specified is either corrupt or is not an executable (.exe
or .com) file.



ALERT: OK to Continue
This message is for advice only. Click OK to continue.



      
Alert: Phone Line Dropped
The reason this message may the following 

· the idle timeout at your Access Provider has expired
· there is a noisy line
· Someone has picked up an extension or call notification is breaking. 

Confirm connection by reference to your modem indications.

If you find that you frequently loose connection to your Access Provider, check both the 
quality of your phone line with your telephone provider and that you haven't got call 
notification (or any such similar service) turned on.

The phone line may not have dropped, there may be a fault in the cable between your 
machine and the modem. More rarely it will be a problem with the COM port on your 
machine or on the modem itself. To resolve these problems replace each component in 
turn by another of the same type until the problem is cleared.



      
Alert: Phone number too short
To check the number, click the No button and make the 
necessary correction. 

If you are sure the number is correct, click the Yes button
and proceed.

For further help refer to Connection Settings 



ALERT: Pics file
This pics file cannot be used.



ALERT: Ping and Trace
You cannot use Ping and Traceroute at the same time.    You must close one before you can run the other.



ALERT: Proceed ?
Click the Yes button to continue or the No button to cancel.



ALERT: Reinstall
To resolve this, you need to reinstall Turnpike.



ALERT: Reinstall Access Provider
Reinstall your Access Provider.



ALERT: Rebuild advised
The database files need to be rebuilt to incorporate the new information, and wherever possible, Turnpike 
offers the chance of doing this now. But as this will take some time, Turnpike offers the option of leaving 
the database files as they are by clicking the No button. However you won't then get the changes.

Database files can also be rebuilt by taking the Rebuild database option from the File menu - assuming 
you have Rebuild files permission.



ALERT: Restart Windows
You can opt not to restart Windows when Turnpike advises you that this needs to be done (for example, 
because you have other applications running), but you must restart Windows before you next try to 
run the Turnpike Connect program. The Connect program will not be able to run until you have 
restarted Windows.



ALERT: Restart Windows advised
We recommend shutting down all applications and restarting Windows.



ALERT: Rule Error
There is an error in this rule at the position indicated. This must be corrected.



ALERT: Seat record missing
To sort this problem out, the System Administrator or some other user with Configure Users permission 
needs to call up the Configure Users dialog within the main Turnpike program.



ALERT: Sensible selection
You need to choose at least one from the supplied list - but no more than five.



ALERT: Sharing violation
The file you are trying to access is being used by another application - possibly on another machine if 
your computer is on a network.



ALERT: Shouldn't appear
An error has occurred in the program.

Please email helpdesk@demon.net with details of the message seen and the circumstances under 
which this message appeared.



ALERT: Smart Too Long
The text you have entered here is too long.



ALERT: Sorry not implemented yet
Sorry, this feature has not been implemented yet.



ALERT: System error
Exit from the program as 'gracefully' as you can, then restart.

It may also be a good idea to restart Windows.



Alert: Too many requests

This is for advice only. Click OK to continue.



ALERT: Too many users
With the standard 'single-access' version of Turnpike, you can only have one copy of the Connect 
program and one copy of the Turnpike program running at any time - though not necessarily always from 
the same machine. With the 'multi-access' version, you still can only run one copy of Connect but you can
have multiple copies of the Turnpike program running, up to the number of seats purchased.



ALERT: Too much
Are you sure about what you are trying to insert ?

As you've triggered this message, the chances are that what you are trying to do won't work anyway.



Alert: Traceroute is not available.

Reinstall TCP/IP from Network in the Windows Control panel.

Click OK to continue.



ALERT: Trial version expiry
The trial version of Turnpike gives access to the Internet for 30 days, with an optional 15-day extension 
for anyone ordering a full copy of Turnpike before the Connect program 'expires'. (To order your full copy 
of Turnpike, ring Demon Sales on 0845 272-2666*)

If the program expires before your full Turnpike package arrives, either email info@turnpike.com (if you 
can) or phone Turnpike Support on 0845 272-2444* with details of your Site ID (which you can find by 
editing the CONNECT.INI file in your TURNPIKE directory). They will then provide you with a 'Site Key' to 
unlock your copy of Turnpike.

* Calls to 0845 272-2666 and 0845 272-2444 may be monitored for training purposes. This information may be used for marketing 
purposes.



ALERT: Try again
Correct the details that you've entered, then try again.



ALERT: Unable to execute program
There's something wrong with the way the button that calls up this program is configured. The program 
may have been moved. Select Toolbar buttons from the Configure menu.

In the dialog displayed ensure that the program details are correct. For further details refer to Toolbar 
configuration dialog.



ALERT: Windows won't close
Windows will not close while you are still connected to the Internet.

Click OK then click the Disconnect button at the left-hand end of the Connect toolbar to continue.



Alert: Wrong Winsock

This version of Turnpike should be using the Windows 95/98 Winsock by default.

If you need further advice or help you can ring support on 0845 272-2444 any time of the day, any day of 
the week.

* Calls to this number are monitored for training purposes. This information may be used for marketing purposes.



ALERT: Wrong emulation
The characters that are being received suggest that you are probably using the wrong emulation e.g. 
ASCII instead of NVT or NVT instead of one of the DEC terminal emulation's - VT100 or VT52.

You can either switch to this emulation now by clicking the appropriate button. Or you can continue using 
your current emulation if you know that what was received wasn't what it appeared to be.



ALERT: Wrong name or password
Click OK to return to the Sign-on dialog and enter the correct information.

If you don't know or can't remember either your sign-on name or your password, consult your System 
Administrator or some other user who has Configure Users permission. They should be able to tell you 
what your sign-on name is and to set a new password for you. Once you've signed on using this 
password, you'll be able to set a new password for yourself by running the main Turnpike program, 
selecting Configure... Users from the File menu and setting this in the Edit sign-on details dialog that is 
displayed.



ALERT: Wrong version
The file you are trying to use was created on an incompatible Turnpike system. At the time of writing, no 
such system existed but it is always possible that one could have subsequently been created.

If you have access to a newer version of Turnpike, try using that.



ALERT: Call cost file corrupted
You must discard this file. 



Reading/Preparing mail or news
If you want to read the mail and news that arrives - or to prepare 
new messages to send out - click the Mail/News button on the 
Connect toolbar. This will call up the main Turnpike program.

 Turnpike Connect will stay running (unless you choose to Exit
from it). Return to Connect by using the Windows Alt Tab facility.



Rebuild Database

The main purpose of Turnpike's Re-build option is to recover wasted disk space left in your newsbase, 
mailbase or address book after earlier entries have been erased. You can also use this option to recover 
your databases, should they become corrupted.

This option is only available when you have Rebuild Files permission. 

1. Close the Turnpike program
2. Run the Connect program
2. Click on File in the menu
3. Select Re-build database 
4. Select Mail, Address Book or News as appropriate from the message that is displayed 

click Cancel if you decide not to rebuild any files after all. 

Turnpike will build a new version containing just the current information from the old version - recovering 
both wasted disk space and as much as possible of the information from the old files.

Related Topics
Software error
Merging databases
Backing up your Turnpike files
Moving Turnpike to another machine or system



Running other Winsock applications

Other applications that use a Winsock can be run while Turnpike is on-line - for example alternative FTP 
programs or WWW browsers. Many of these are available as "shareware" applications and can be 
fetched from the Internet using FTP.

To use such an application, you will need to install the application as an icon on your Windows desktop in 
the usual way. If you have difficulty doing this, you will need to consult the supplier of the application.

To run the application, start Turnpike Connect and Connect to your Access Provider in the usual way, then
return to the Windows Program Manager and simply double click on the icon for the other Winsock 
application.

Related Topics
Winsocks
Going On Line



Sending / Receiving mail

When you go on-line, you will probably want to send any mail messages or news articles that are sitting in
an Out tray and to receive any mail that has been sent to you.

Before email can be received or delivered, information such as where your email messages will arrive 
from needs to be recorded - e.g. the details of your POP3 mailbox(es) if you have any.

Initially all the information that's needed will either be available to Turnpike from the standard script for 
your Access Provider or from answers given when this Access Provider was first selected. Turnpike will 
also have arranged that mail will automatically be sent and received whenever you go on-line.

The default is for both of these actions to be carried out automatically whenever you go on-line.

    To configure email transfer you must have Connect Admin permission:

1. Click on Configure;
2. Select Email Transfer, the Configure email send and receive dialog appears.

· If you want mail to be sent and received automatically, check the Send automatically and 
Receive automatically option boxes.

· To keep either action under your control, clear one or both the Send automatically and Receive 
automatically options boxes. 

The Configure Email send and receive dialog enables you to confirm the settings made and when 
necessary to change them. The associated Configure POP3 Mail Collection dialog enables you to setup 
further POP3 mailboxes as you require.

Configure Email send and receive dialog also enables you to set an option to return confirmation that a 
message has been received. 

While news is being transferred, messages in the details section of the main Connect display show how 
many items to expect, how many have been collected, and how many have been filed.

The rate at which data is currently being transferred in characters per second (cps) and reporting errors 
(overruns) in this transmission is also given.

Related Topics
Configure email send and receive dialog
Reading and Preparing Mail
Going on-line
Mail and News Indications and Controls



Sending commands line by line (in Telnet)

When you telnet to a remote computer, the commands you issue will normally be sent character-by-
character, but if your computer is emulating either an NVT or a simple ASCII terminal, these commands 
can also be sent line-by-line.

Line-by-line is often preferred to character-by-character because it allows you to edit your commands 
before they are sent. It also avoids the character-echoing effect you can get when commands are sent 
character-by-character.

To arrange that commands are sent line-by-line, take the Emulation option from the Options menu, then 
check the Buffer lines box in the dialog that's displayed.

Related Topics 
Introduction to telnet
Telnet terminal emulation



Setting the Timezone

To determine when a mail message was sent, all times are converted to Universal Co-ordinated Time 
(UTC). The adjustment required to convert your local times into UTC depends on the timezone in which 
you work.

· Timezone Dialog
This dialog is called up by selecting Timezone from the Configure menu.

Synchronise with: the address of the timeserver, which Turnpike will use as a time reference. 
Generally this will be set for you.

Automatically set the PC clock
· If you want Turnpike to set your host PC's clock to match your time server; check this option.
· If you want your PC to remain synchronised to some other time standard, leave this box clear.

Local timezone: Enter your winter timezone - either by its standard abbreviation or the number of 
hours and minutes you are ahead or behind GMT in winter. Enter this as a four-digit number hhmm, 
preceded by a + if you are ahead of GMT or a - if you are behind GMT.

Examples:
East Coast of America    5 hours behind GMT. Timezone entry. - 0500.
South Australia 10½ hrs ahead of GMT. Timezone entry. +1030.

Summertime:  select one of the options to apply local summertime or Daylight Saving rules at your 
location.

The next change will be:    For users in the UK this will be set for you. If you want to set or change it, 
select the other option and enter the details in the text box.

When the clocks go... Select either forward or back 1 hour.

To help you ensure that you set the Timezone correctly, Turnpike responds to the setting you 
make with an indication of where you are probably located. If it is very wrong, check if your entry is minus 
where is should be plus (or vice versa).



Setting where Mail and News is stored

When Turnpike is installed, it automatically creates NEWS and MAIL directories alongside the Turnpike 
Connect program and sets up both Turnpike Connect and the main Turnpike program to use these 
directories. If you run out of space on the current disk, you will need to move either the NEWS directory or
the MAIL directory (or perhaps both) to a different disk.

If you need to move the whole of Turnpike to another machine or another system, click here).

Close the Turnpike programs both on the host machine and on any other machine on your system. 
Use standard File Manager actions to move the directories to their new location.

Record the new File Path information within both Turnpike and Connect.
If these files are accessed from other machines across a network, inform your colleagues of the new 
location of these files. Ensure that they record the new details in the copies of Turnpike they use.

There are two ways of recording these details:

· If the Sign-on dialog is displayed when the program is run

1. Click the Paths button in the Sign-on dialog. The File Paths dialog appears.

2. Set the new path information.

· If the Sign-on dialog isn’t displayed

1. Edit the TURNPIKE.INI and the CONNECT.INI files in your Turnpike directory.

2. Record the new Newspath and Mailpath in the [PATHS] section of these files.

Related Topics
File Paths dialog
Moving Turnpike to another machine/system
Merge databases



Setup - Password Advice

Your password can be any mixture of 6 or more upper-case letters, lower-case letters, digits and 
punctuation marks and may not include spaces.

Use something you can remember, but not something that's easy for someone else to guess. It is not 
advisable to use the name of someone in your family, your birth date, your National Insurance or your car 
registration number. Avoid sequences of digits and letters that are easy to type, words picked out of even 
very obscure dictionaries or simple variations of the above - because such things would be easily found 
by a computer cracker program.

It is recommended that your password is 6 - 8 characters, fitting one or more of the following descriptions:

· A word with unusual capitalisation;
· A word with unlikely misspelling;
· The first letters of a phrase;
· A phrase stripped of both spaces and vowels;
· Interleaved words;
· A mixture of two or more short words and digits or punctuation marks.

You should also note that while you can set passwords up to 16 characters long, only the first 8 
characters will actually be checked. These first 8 characters should contain a mixture of letters and digits.

Click here if you need any further information before making your selection.



Setup - Help

If you need further advice or help on how to complete the setup Wizard, you can ring 0845 272 2666* - 
any time of the day, any day of the week.

You can also use this number for any of the following:

· For details about opening an account with Demon Internet;
· You would rather pay by cheque;
· You can't use the setup Wizard to sign up for your Free Trial e.g. because you don't have a credit card

or you don't have a UK address.

* Calls to this number are monitored for training purposes. This information may be used for marketing purposes.



Sharing buffer overflow

This message usually means that the SHARE command in your config.sys or autoexec.bat is not setting 
enough buffer space and/or file locks.

If you need SHARE for DOS programs that you run prior to loading Windows, change the parameters of 
your share command to give more buffer space and more locks. If you are not sure how to do this, consult
your DOS manual or type share /? at a DOS prompt.

However, if you do not need SHARE then remove references to it from your config.sys and/or autoexec.bat
file. File sharing for Windows is normally handled by VSHARE. This is loaded by the command 
device=*vshare line in the [386Enh] section of \windows\system.ini. If you do not already have VSHARE on 
your system, reinstalling Turnpike will install it for you.

If Turnpike reports 'sharing buffer overflow' and you are not using SHARE, you may be running an out-of-
date version of VSHARE. Try removing the ini command line, then reinstall Turnpike.

Related Topics
Troubleshooting



Sign-on names
Sign-on names are the names by which the different users of your system are known to
Turnpike. If you are the person who installed this copy of Turnpike your sign-on name 
will be the email name you gave at that time. Otherwise ask your system administrator 
for the sign-on name. Generally the same rules apply to sign-on names as email 
names. Typically a user's sign-on name will also be their principal email name, though 
this does not have to be so. For further details refer to the Set-Up book - Allocating 
users to seats.



Signing on

If you are the sole user of your copy of Turnpike when you run either the main Turnpike program or the 
associated Connect program, that program will simply open.

If you share your system with other users or you have chosen to protect your mail files against 
unauthorised access with a password, Turnpike's Sign-on dialog box will appear.

Enter your Sign-on name, or if you have used this name before, select it from the drop-down list.
Enter your password (if any).
Click the OK button and Turnpike will open.

Turnpike remembers the last Sign-on name and file paths to be used. If you were the last user, just enter 
the password and then click OK or just click OK.

The Sign-on dialog, Sign-on names and allocation of seats are set from the main Turnpike 
program.

Related Topics
Sign-on name
Paths
Please type Site ID dialog



Site ID
The Site ID is the serial number of your copy of Turnpike. The Site ID of any Evaluation
copy of Turnpike is generated automatically. You will find the Site ID for a full copy of 
Turnpike on the CD pack. You will have been asked to enter this ID the first time the full
copy of Turnpike was run. Anyone who has permission to run this Connect program can
inspect the Site ID by: 

clicking Configure and then selecting Site Key;
or Clicking the Site Key button on the main Sign-on dialog.

In either case the Site Specific Details dialog will appear. If you know the Site Secret 
you are able to change the Site ID.

    Only the System Administrator or someone who knows the Site Secret can 
change the Site ID.



Please type Site ID dialog

This dialog is displayed when you install the Connect program.

· Enter the Site ID for the copy of Turnpike you are using. This is proof that you have a legal copy of 
the program. The Site ID is on the Registration Card.

You can use upper or lower case letters when you enter your site ID (they will be changed to upper 
case for you). 0 or the letter O is accepted as 0. 
1 is interpreted as the number one, a lowercase or uppercase L.

· Enter a Site Secret. This will be used to encrypt your mail messages and will prevent any mail being 
read simply by opening the mail files.

The Site Secret is up to you. Any word or phrase will do. Keep a record of it. If you ever have to 
reinstall your Turnpike system from scratch you must use the same site secret.

 If you reinstall at any time you must use the same Site Secret. If you use a different Site Secret, 
you won't be able to read any of the mail messages received using the previous installation. 

Related Topics
Signing on



Site Key
You will require a site key if you are using the trial version of 
Turnpike and you want to update to a full version. You will 
also require a new site key if you want to increase the number
of users of your copy of Turnpike

Site keys can be issued for one user or for multiple users (up 
to 99).

For further details refer to the Site Specific Details dialog.



      
Site Secret
The Site Secret is a code word that is used (together with the Site ID) to encrypt mail messages so 
that they can't be read by simply opening the mail files. You may leave the Site Secret blank. If you 
do your mail messages will only be encrypted with the Site ID. Another user may know this.

When you enter a Site Secret, anyone who tried to read your mail files would need to know both 
your Site ID and your Site Secret. You will probably only need to enter your Site Secret once.

    Ensure you keep a record of both your Site Secret and your Site ID in the event that you ever
have to reinstall your Turnpike system. If you don't use the same Site Secret again, you won't be able 
to read any of the mail messages that were received using the previous installation.

    If a Site Secret is lost the system administrator can set a new Site Secret for you.



Site Specific Details dialog

This dialog is displayed when you select either the Site Key from the Configure menu or you click the 
Site Key button on the Sign-on dialog.

The Sign-on dialog shows the Site ID and any Site key that has been set. Any password set is shown as 
******. The details given are generally for information. However, you may need to refer to this dialog if you 
add new users. 

You are only able to change the details in this dialog if you have Administrator permission - or if 
you know the Site Secret.

· To verify you have the correct site:
1. Enter the Site Secret;
2. Click the Check Secret button.

When this is verified, you can also set a different Site Secret.

You can use upper or lower case letters when you enter your site ID (they will be changed to upper 
case for you).
0 or the letter O is accepted as 0.
1 is interpreted as the number one, a lowercase or uppercase L.



Snapshot Menu

Select the Snapshot option to record the current screen contents and save it to a file on disk.

Related Topics
Logging Options.



Software error nnn

Software Error followed by a number means that one of Turnpike's internal consistency checks have 
failed. This may happen if a file is damaged due to the power being cut, or if some other program 
crashes, while Connect is saving data. 

If the error occurs frequently, it could suggest the machine has a problem with, 
· the reliable storage of data; faults with RAM or the hard disk
· an over-clocked processor. 
· software, perhaps a virus. 

These errors are usually associated with either the news database or the address book. 
Turnpike takes actions that minimise affects to the mail database.

· To clear the error
1. Shutdown Turnpike 
2. To ensure your file and directory structure is valid, run the Windows utility SCANDISK.

· If the error IS reported to be in the file USERNEWS, delete the USERNEWS file. 
Information about which threads you have read and marked as interesting or uninteresting will be 
lost

· If the error is NOT reported to be in USERNEWS, rebuild the affected database.
Rebuilding a database recreates all the indexes and other secondary information, and discards any
damaged data.

Sometimes it is clear that you have a problem with your mail or news databases, but Turnpike reports 
an error before it has run long enough to give you a chance to do a database rebuild. To correct this, 
rename the \turnpike\news\newsbase (or \turnpike\mail\mailbase) file to something else and then start 
Turnpike. The program will spot the missing file and offer to rebuild. Before accepting the offer, 
switch task (e.g. to File Manager or Windows Explorer) and rename the file back to its original name. 
Turnpike will then rebuild. If you don't rename the file back again, more information will be lost than 
necessary.

If the error is reported to be in the file USERNEWS then rebuilding the news database will not help. 
Instead, you need to delete the USERNEWS file. Note that this will lose information about which 
threads you have read and marked as interesting or uninteresting. Once again, use SCANDISK before 
running Turnpike again.

Related Topics
Troubleshooting
Rebuilding databases



Colour Selection: Status Colours dialog

This dialog is opened bychoosing either:

· Colour from the Options menu
· Windows Colour from the Options menu and then click the Alter button on the Status Colours dialog

Click the down arrow in the selection box at the bottom of the dialog. 

If you have opened this dialog from the Colour option the menu will list colour locattions fro Logging, 
Telnet, Finger and Ping.
If you have opened this dialog by clicking Alter on the Status colours dialog, the menu will list colour 
locations on the main connect window.

In either case for each item in the menu the colour currently set is shown in the ColorSolid box. 
The dialog offers both a palette of Basic colours and a complete colour spectrum from which you are able 
to select a custom colour. If you want, you can add the colours you pick out from the colour spectrum to 
an additional palette of ‘Custom’ colours.

To use a colour from a palette, click on the colour in the palette.
To choose a custom colour from the spectrum, click on the colour you want in the spectrum. Set its 
‘luminosity’ (the amount of white/black you want in the colour) by clicking on the sample bar to the right of 
the spectrum.

To add this custom colour to the Custom palette, click the Add to Custom Colors button.
If you want the new colour to replace an existing colour in the Custom palette, select the entry in the 
Custom palette before setting up the new colour. The ‘old’ colour will be replaced by the new one when 
you click the Add to Custom Colors button.

If you want to return to the default colours, click the Default button on the dialog.

Related Topics
Options menu



Subscribing to newsgroups

To follow the discussions in a particular newsgroup, you must subscribe to it. You will then have the 
articles that are contributed to this newsgroup downloaded to your PC. To read the articles, the 
newsgroup must be included in a newsstand.

You will only be able to subscribe to a Newsgroup if you have News Admin permission. To subscribe to a 
Newsgroup either select a newsgroup for inclusion in a newsstand or add them to the master list of 
subscribed newsgroups that Turnpike keeps.

In addition to adding further newsgroups through the Newsgroup Subscriptions dialog, you are also 
able to:
· remove newsgroups that are no longer required
· set the length of time each article is held (the Expiry time)
· specify whether the newsgroup is to be downloaded in full or just 'browsed'.

    For further details of subscribing to Newsgroups refer to Help in the main Turnpike program.

Related Topics 
Changing Subscription information
Browsing a Newsgroup
Moderated groups



Taking a snapshot

If you want a snapshot of the current screen display, simply select Snapshot from the menu bar. This 
saves the contents of the current screen to a file.

If your PC is being used as a Network Virtual Terminal (NVT) to telnet to a remote computer, the snapshot
will record the last 25 lines of commands and responses.

Related Topics
Logging



      
Telnet Emulation option

This option calls up the Telnet Sessions dialog. You use this dialog to set 
which type of terminal your system emulates when you log in to a remote 
computer using Telnet. You also use this dialog to set the rules by which 
output on your screen is wrapped from line to line and whether your 
command lines are sent character by character or line by line when your 
computer is emulating either an NVT or a simple ASCII terminal. You are 
able to call up this option, either from the main Configure menu or from 
the Options menu when you are using Telnet.



Telnet Keyboard dialog

This dialog enables you to configure your PC's keyboard in whichever way you find best when using 
Telnet.

Phrases: Use this part of the screen to define any command strings including special characters that you 
would like have available on your PC's function keys.

1. The shift in which the current set of phrases will be available is selected by clicking the Normal, 
Shift, Alt and Control options to the right of the list.

2. The Phrases shown against the background of the dialog cannot be changed.

VT100 keyboard layout: If your PC is currently emulating a DEC terminal, use this part of the dialog to 
set whether the keypad area of your keyboard will have the standard PC layout or mimic that on a DEC 
terminal.

The option you select affects whether F5 - F8 are available to issue command strings. If you opt for the 
standard PC layout, F5 - F8 take on the role of PF1 - PF4. (In the DEC layout, the top four keys of the 
keypad act as PF1 - PF4.).

Related Topics 
Introduction to telnet
Telnet terminal emulation
DEC/PC layouts



      
Telnet Keyboard option

Calls up a dialog through which you can setup function keys to issue 
frequently used Telnet commands and set whether the numeric keypad on 
your PC has the standard PC layout or emulates the numeric keypad on a 
DEC terminal.

If you opt for the standard PC layout, function keys F5 - F8 will take on the 
role of the programmable function keys PF1 - PF4 (set by the remote 
application). If you opt for the DEC layout, the top row of the numeric 
keypad will act as PF1 - PF4.

Click here for further information about the Keyboard Emulation dialog or 
press F1 to call up this Help file when the dialog is on your screen.



Telnet Session Defaults dialog

This dialog enables you to set information about how your PC will act as it communicates by Telnet with a 
remote computer.

Emulation Select the option that's required. If Automatic is selected, the emulation that is used will 
be set by negotiation between Turnpike and the remote computer when you connect to 
this computer.

Cursor Select Solid (or thin); Flashing (or not flashing) as required.

Buffer lines Check this box if you want commands to be sent line-by-line.

Auto-wrap If the output from the remote computer needs to be wrapped from line to line by Turnpike 
at a particular column, check this box and set the column (number of characters) at which
the lines should be wrapped.

Related Topics 
Introduction to telnet
Telnet terminal emulation



Telnet Terminal emulation

The terminal your PC emulates when you are connected to a remote computer is usually set to the best 
possible option by negotiation between Turnpike and the remote computer.

Should you need to set a specific emulation, select the Terminal emulation option from the Options menu 
to display the Telnet Sessions default dialog. This dialog enables you to set the emulation, and details such as 
the type of cursor (thin or solid, flashing or static) and the column at which output to the screen should be 
wrapped.

As far as Telnet is concerned, there's no difference between a VT102 terminal and a VT100 terminal.

Related Topics 
Introduction to telnet



      
Telnet function keys
The standard assignments for the function keys 
during Telnet are:

F1 Help
F2 Are you there
F3 Interrupt Process
F4 Abort Output

F5-F8 In DEC keyboard layout, user defined
In PC keyboard layout PF1-PF4

F9 Switch view
F10 Toggle menu bar

F11-F12 User defined



Telnet menus

File
Edit
Commands
Options
Snapshot
Window
Help



      
Telnet special characters
Special characters can be included in Telnet function key 
phrases as follows:

\R carriage return followed by line feed
\L line feed only
\T tab
\\\

Lower case r, l and t have the same effect as the upper case
shown.

\ followed by any other character or at the end of the phrase 
represents \



Introduction to Telnet

Telnet enables you to log into and use another computer on the Internet.

A wide range of information resources held on computers on the Internet are accessed using Telnet - 
catalogues, news listings, stock exchange reports etc. In some cases, you need to open an account 
before you can use the information; in other cases, the information is available for free.

Details of the information resources available by Telnet are given in catalogues of Internet services. The 
entry for the service will tell you:

· The address that you need to telnet to
· Any special 'port' you need to quote

Where appropriate, it should also tell you the log-in name that you will need to use.

Turnpike automatically keeps a list of the addresses and port numbers of the services you call up.
When you want to log in to one of these services again, you can readily call up the information you need.

A feature of telnetting from Turnpike is that Turnpike automatically 'negotiates' with the server on the 
remote computer the best terminal emulation to use and the best settings for the various operating 
parameters. You don't need to set these things yourself (though you can set a specific emulation if you 
want).

If your PC is set to emulate any of the DEC terminals, you are able to setup your PC keyboard so that the 
numeric keypad mimics the numeric keypad on a DEC terminal. In particular, the top four keys of this 
keypad take on the role of the programmable function keys PF1 - PF4. (If you opt to keep the standard 
PC layout for this keypad, PF1 - PF4 are put onto function keys F5 - F8.) You may well find selecting the 
DEC layout makes it easier to follow the instructions given by the application you select.

While some commands are preset, you are able to set your PC function keys to issue the command you 
use most often.

If a Telnet button is not shown on your toolbar, it is easy to add one -- refer to Toolbar Configuration

Related Topics
Calling up information by Telnet



      
The Main Turnpike Program
The 'main Turnpike program' is the TURNPIKE.EXE program 
which is used to prepare and read Mail and News. It can be 
started from within the Connect program by clicking the Mail / 
News button on the Connect program toolbar.



The Permissions

The different permission(s) that users may be given are as follows:

Administrator Able to configure Users. This includes adding new users, setting other users sign-
on details and permissions and permission to rebuild datafiles. The administrator 
can also set (and apply) all other permissions.

Connect Admin Able to alter the Host, Timezone, Mail Transfer, News Collection and Service 
Access details recorded through the Configure menu in the Connect program. Also
allowed to Configure the Toolbar in the Connect program and to make permanent 
changes to Call cost logging.

Dialling Admin Able to alter the New/Edit Connection dialog in the Connect program.

Email Admin Configure Email Routeing in the main Turnpike program. Able to set how email is 
distributed to different users and who handles Dead Letter Mail.

News Admin Configure Newsgroups in the main Turnpike program. Able to select which 
newsgroups are subscribed to, to set how long articles remain on your disk before 
being expired and to restrict access to particular newsgroups.

Alter Users Configure Users. Able to add new users, set other users' sign-on details and 
permissions.

Alter Workgroups Able to Configure Workgroups using the main Turnpike program.

Alter Names Able to setup Email names for any user, using the main Turnpike program.

Add Email Names Able to setup Email names for themselves, using the main Turnpike program.

Connect to Net Able to run the Connect program and connect to your Access Provider.

Keep articles Able to mark articles to be kept beyond their normal expiry time.

Kill articles Able to kill individual news articles and to setup Kill rules.

List Subscribe Able to setup mailing lists as pseudo-newsgroups available to any user.

Rebuild Files Rebuild the news database, the mail database or the address book as required.

Ratings Admin Able to set the newsgroup ratings controlling which newsgroups can be seen by 
different users.

Serve POP3 Able to access the mail in their Turnpike mailbox from outside their Turnpike 
system. 

        Permissions are set from the main Turnpike program.



Time Server
A Time server is a computer on the Internet that is 
setup to issue UTC time.



Toolbar Configuration dialog 

When Turnpike is installed, you will have four buttons on the Toolbar. These default buttons are Call 
costs, Mail/News, WWW, and FTP. 

If you click the Default all button, Telnet, Finger, Ping and Traceroute buttons will be automatically added 
to the toolbar for you.

You are also able to access these applications and others, from the Function menu.

You are able to have up to 20 buttons on the Toolbar. The Toolbar configuration dialog enables you to 
add (and remove) buttons as you wish. 

If have you used all 20 buttons and want to add further buttons for external programs, initiate the 
internal commands from the Function menu.

· To set a button to call a particular application
1. From the Configure menu, select Toolbar buttons and the Toolbar Configuration dialog will 

appear. Separate pages are used to set each button. The page number represents the button 
position from left to right along the toolbar. You can leave spaces blank if you wish.

2. Select the page for the button you want to set:

· Button Text: Enter the text you want to appear on the button.
The number of characters you are able to use for Button text will depend 
on the font you use but should generally be limited to 10.

· Prompt Text: As you move your cursor over the toolbar button, the text entered here in 
the dialog will appear in the status bar at the bottom of the screen.

· Internal Command: Select the internal command option, then click the down arrow and select 
an item from the list.

    
If you don't want the button to be used, check Internal command and select Unassigned from 
the list.

· External Command
1. Select the External Command option.
2. Use the Browse button to locate an .EXE file of the program you want it to run.

The working path will be set for you. Use the Browse button if you want to change the path.
2. Enter any parameters you want to set.
3 Make any changes you want to the Button text and the Prompt text.

· Default all click this button to restore the toolbar to the eight button default state as stated 
above.

When you've made all the assignments you want, click the OK button to save your changes.

Related Topics
Function menu





Traceroute

The Turnpike Traceroute option, provides information about the route currently being taken between your 
machine and another Internet address.

To use this option:

· Click the Traceroute button on the toolbar
· Enter the appropriate domain name in the dialog that's displayed
· Then click the Start button.

Turnpike works out, from a series of sample messages, the sequence of machines through which 
messages sent from you to the specified host will pass. A report is then produced listing the address of 
each machine and the different times taken by the sample messages, for each stage of the journey; 
except where they've met with no reply.

It also reports whether the host at the destination was on-line (shown as !E) or off-line (shown as !H).

You should only use Traceroute under direction from your Access Provider or some other authority 
who is able to interpret the information in the report. This tool makes intensive use of Internet 
resources and should not be used for idle investigation.

If a Traceroute button is not shown on your toolbar, it is easy to add one -- refer to Toolbar Configuration



Troubleshooting

Difficulty connecting to your Access Provider

Keeping that connection

Errors (  overruns  )  

'Software' errors

Bind error, address in use

Sharing buffer overflow

'Winsock' errors - No buffer space

The speed at which news is collected

A serious problem has occurred in the Connect program



Turnpike Initial Setup - Demon Internet Account

Demon Internet is today's largest and fastest-growing Internet provider in Europe and the market leader 
in low-cost Internet access in the UK.

With the copy of Turnpike you're installing, you can also have a FREE trial of Demon Internet's service, 
which gives you:

· Full access to the Internet direct from your own computer.
· Local call access to Demon's network thus helping you to cut the cost of staying on-line.
· Unlimited Email; allowing you to send and receive as much email as you like.
· Access to all the different news discussion groups (currently over 28,000) via Demon's local News 

server.
· Unlimited access to the World Wide Web.
· FREE 15Mb Web space.
· Access to information anywhere in the world, using Demon's high-speed international links and 

modems.
· Free 24-hour, 7-days a week technical support.

Click here if you need any further information.

Even if you have an Internet account with someone else, why not see what Demon 
Internet has to offer?



Turnpike Initial Setup -    Enter Hostname

Enter at least one hostname, between 3 and 16 characters long.

You can use any mixture of lower-case letters, hyphens and digits but you must start with a letter and you 
mustn't end with a hyphen or have two hyphens together. Do not include spaces.



Turnpike Initial Setup - Have account with another ISP

If your Access Provider doesn't appear in this list, then in the first instance contact your Access Provider 
and ask if they can provide a 'script' (or .ACC file) for using their service with Turnpike. If they can't, call 
Support on  0845 272-2444*.

If you won't be using Turnpike to dial, you can record the information Turnpike needs to know about your 
Access Provider by taking the Unknown Access Provider option offered at the top of the list of Access 
Providers.

* Calls to this number are monitored for training purposes. This information may be used for marketing 
purposes.



Turnpike Initial Setup - Host

Your hostname is the part of your demon.co.uk address immediately before the demon.co.uk. For 
example, if your demon.co.uk address is fred@anywhere.demon.co.uk your hostname would be 
anywhere.

Your login password is the one you give when logging on to Demon.

For details of the number to ring for further help refer to Demon Internet - Subscriber Registration.



Turnpike Initial Setup - Modem and Connections

Before you are able to select a modem you must install the modem(s) you use, using the Windows 95/98 
Control panel.

Click the down arrow and select the Modem you want to use. You will be able to change this choice later if
you wish by selecting the Edit button on the Connect to Internet dialog. This dialog will be displayed 
when you have completed this setup procedure.

Where applicable, check the ISDN box.

· I would like an account with Demon Internet
Connection: Enter the phone number you will be dialling from.

· I have an existing account with Demon Internet or another provider
Click the down arrow and choose a PoP to dial to. The phone number will be entered for you. 

If you have been given a special number to dial to, type this over the number given.
Take care not to touch the Point of Presence slot again. If you do, the number you have entered will 
be lost.

When necessary you are able to change the PoP when you have completed this procedure, by 
selecting Email Transfer from the Configuration menu.



Turnpike Initial Setup - Names

Full name: Enter the name you want Turnpike to use for any email messages or news articles you 
prepare. These names will then be automatically included for you. You can change the names entered 
here in the main Turnpike program, by selecting Configure... Users from the File menu.

Email name: Your email name will be the part of your email address before the @. If you want your email 
address to be fred@yourhost.demon.co.uk, enter fred as your email name. This can also be changed 
later.

You are able to give yourself a range of email names to use. For details see Email names.

Click here if you need any further information before making your selection.



Turnpike Initial Setup - Review

To review the answers you've given on the previous pages, click Back.

To finish this part of the procedure, click Continue.



Turnpike Initial Setup - Site ID

Enter your Site ID in the top slot. This can be found on the CD package.

Then enter a suitable Site Secret in the second slot.

Only click the Site Key button if you have been told a Site Key to enter.

When typing the Site ID, you can use any combination of upper and lower case characters you like as any
lower case characters will be automatically switched to upper case for you. You also don't need to worry 
whether 0 is a zero or the letter O, or 1 is the number one, a little l or a capital 'i': they're actually numbers 
but the letters will also be accepted.

Click here if you need any further information.



Turnpike Initial Setup - Welcome to Turnpike Connect

This Setup Wizard will ask you for information such as which Access Provider (Internet Service Provider) 
you want to use.

If at any stage you want to review or change the information you gave on an earlier screen, use the 
Back button to work through the previous screens. If you click Cancel you will have to restart the 
installation procedure

This Help text applies to Turnpike v4.02

In this version the functions of the previous evaluation and full versions of the program have been merged
into a single integrated version.

Otherwise the program is the same.

Version 4.02S is the standard version and is available for a free trial period through Demon Internet only.
Version 4.02U is the full version with access available througn all ISPs
Version 4.02M is as version U and allows multi user access

A site key is required for version U
A site key is required for each user of version M.

To start, click the Next button at the bottom of the display.



UTC
Universal Co-ordinated Time(UTC) This an international 
standard formerly known as GMT (Greenwich Mean Time). 
The initials are UTC rather than UCT because the 
abbreviation is based on French not English.



Unregistered Evaluation Version dialog

This dialog automatically appears whenever an Evaluation copy of Turnpike is run, to advise when this 
time-limited copy of Turnpike will 'expire'.

Separate dates are given for the main Turnpike program and the Connect program.

The main Turnpike program will continue to run for a few more days to enable you to export any mail.

Tick the box at the bottom of the dialog when you have ordered a full copy of Turnpike.

If the full copy hasn't arrived by the time this Evaluation version has expired, ring Technical Support on 
0845 272-2444* and ask for a 'Key' with which to extend the life of the Evaluation version.

* Calls to this number may be monitored for training purposes. This information may be used for marketing purposes.

To show what version of Turnpike you are using, click Help and select the About Turnpike option.
See also Upgrading in Turnpike Help.



      
Updating the list of newsgroups
New newsgroups appear and old newsgroups disappear almost daily so 
whenever Turnpike picks up articles it also picks up a list of amendments 
to make to the list of newsgroups it offers.

Alternatively, if you have Connect Admin permission, you are able to select
a new list by selecting the Update option in the Configure News Server  
dialog.
This is particularly useful if you change the News server you use e.g. 
because you change Access Provider. This is because not all News 
servers carry the same range of newsgroups.



Using Turnpike Connect Help

Use the following facilities to get help in Turnpike:
· For help on the current display press the F1 key;
· By pressing Shift F1 and then clicking on that part of the screen from which you require further 

information;
· Use a browse sequence to learn about a subject as a whole;.
· Click on any item displayed green and underlined - see Jumps and Pop ups below;
· Click Help in the menu to display a submenu for Index, Using Help, Show Hints & Tips and About 

Turnpike;
· Read the Tutorial.

· Browse Sequences    
As far as possible, the help files for each subject have been arranged in a sequence. From any topic 
click the browse buttons to read each subsequent or previous topic in the sequence. In the Help 
Contents tab page each sequence is shown as a book icon. If you are new to a subject you may find 
it useful to print the complete sequence to study at your leisure.

· Help Topics : Turnpike Help 
When you select Help, and then Using Help, the Help Topics window opens with the following three 
pages:

· Contents: A list of topics similar to the Table of Contents in a book. Subjects are listed as books 
and topics. Click on a book icon to show the next level of information, this may be a further book or a 
list of topics. Click on a question mark icon to open the help text for a topic.

· Index: Lists key phrases in alphabetical order. Either enter an item to search for or select an item.
Double-click on the selected item or click the display button to display the help text. If a sublist is 
displayed, repeat the process by double-clicking on an item to display the required help page.

· Find: From this tab you are able to perform a full text search of the help files for any word or 
phrase.

· Jumps and Pop ups
When you click on a word fully underlined in green you will jump to that topic page, replacing your 
current window. Click Back in the menu to return to previous help pages. 

When you click on a word with a dotted underline, a ‘Pop up’ help box will open over your current 
window. Pop ups are often used for definitions of terms. Click anywhere to close the Pop up box.

Use the tab key to highlight each jump or Pop up on a help topic page

· To return to a Help page
· Click on a forward or back browse button on the toolbar.
· Click on Options in the help menu and select History. Double-click on any item in the list 

displayed.

From any help page click Contents or Index tab to display the Help Topics window.

Use Bookmark in the Help menu to mark a help pages you want to return to later. 



You are able to move, resize and close a help window as for any other window.

· Dialog Boxes
For help on the current display, click F1 to display associated    help text. Alternatively, click the help 
button on the dialog.

To show which version of Turnpike you are using, select click Help and select the About Turnpike option.
For further details on using Windows help select Using Help from the Help menu.

Related Topics
Welcome to Turnpike Connect



Viewing a Telnet session

Press F9 to switch between the Terminal Screen and the Session Screen
Alternatively, select the option from the Windows menu.

The 'Terminal Screen' screen shows the contents of the current terminal screen. It is normally shown 
while commands are being given or when responses are received.

In quiet periods, you are able to switch to 'Session review' mode. In this mode you can look back over a 
log of the entire session.

When your PC is emulating a Network Virtual Terminal (NVT), there is no separate Session view as the
Terminal screen itself provides a log of the entire session which you can scroll back over during quiet 
periods.

Related Topics
Windows menu: Terminal screen
Windows menu: Session review



World Wide Web

The World Wide Web - or 'WWW' or 'the Web' as it's more commonly known - is an exciting and powerful 
way of calling up information over the Internet.

What you call up over the Web are pages of information, typically laid out like the pages of a magazine 
with lots of pictures and other graphics. The system allows different text styles and graphics to be used so
it's pretty much de rigeur for anyone setting up 'Web pages' to use these to make their pages as attractive
as possible.

There are pages on a vast range of topics - from world events to obscure musical instruments.    You can 
find weather reports, stock market reports, restaurant reports, product information, news pages and 
articles from magazines. 

A feature of these pages is the links they provided to other pages of information. Just click a link to go to 
further pages of information. Links may be underlined words or phrases, but may include pictures. 
Whereas the links in a Help file just call up a different part of the same file, the links on Web pages use a 
system known as 'hypertext' to call up completely separate files. Through the magic of the Internet these 
files may be held anywhere in the world.

The information available through the Web is called up by using a program known as a Web browser (so 
called because the process of searching the Web is described as 'browsing'). The browser provided for 
use with Turnpike is Microsoft Internet Explorer.

When you want to get information from the Web:
· Connect to your Access Provider.
· Then click the WWW button on the toolbar to start Microsoft Internet Explorer.

To start with, you will see whichever Web page is currently set as its 'starting page'. 

You can use the links on the page that's currently displayed to call up other pages and so on until you find
the information you want. 

Alternatively, you can enter the address of the page you want. This address is called a Uniform Resource 
Locator(URL). All URLs start http://.... ) 

 
If there isn't an Address slot at the top of the screen, call up the View menu and select Address Bar.

If you don’t know the address click the Search button. Enter a word or phrase and then press enter. You 
may find a very large number of possible addresses. Most of the search facilities enable you to refine your
search.

Some sites may be many pages long. To save you time on-line just save the page to a file and either print
the file or read it off line.

For further information about using Micosoft Internet Explorer, press F1 when you are using Internet 
Explorer to call up its own Help information. 

Turnpike mail and news provides a facility to browse URLs from mail and news - go to Browsing URLs in
Turnpike Help



Welcome to Turnpike Connect
                                                                                              
From this part of the Turnpike program you are able to:
· Configure Connect

· Set details of the Host, including your local domain
· Set the time zone you work in
· Set up how you want to send and receive Email
· Determine where you will get Usenet news articles from, and how news will be handled
· Add new, and alter details of your Access Provider
· See and change your Site key
· Add / Remove Toolbar buttons

· Go on-line to send and receive email messages
· Download articles from the newsgroups you subscribe to
· Use the various on-line services that the Internet offers
· Browse the World Wide Web
· Use Telnet to consult library catalogues and databases the world over
· Use FTP to pick up copies of software and other files available over the Internet.

For information on any of the above topics, simply click on the topic you are interested in.

If you are new to Turnpike, read the Tutorial in the main Turnpike program.

Related Topics
Using Turnpike Connect Help
Reading and Preparing Mail



Which modem to pick

The Universal modem setup will work well for most types of modem. If you need to use a specific modem 
setup, look at your modem and/or its manual and determine both the name of its manufacturer and its full 
model name. If stated note the name of the modem(s) your modem is said to be compatible with. Now 
scan the part of the list below the 'Generic' entries for this make and model.

Turnpike supports many modems, but it's always possible recently released modems may not be 
included.

If your modem is not in the list, look for a modem with a very similar name to yours. If none of the similar 
names work, try the Universal setup. If that doesn't work, try one of the generic modem entries, though 
please note that you may not then be running your modem as fast or as reliably as possible.

There are several families of generic modem driver files, and you need to select the right family. If the 
hints below, or reading the modem manual don't help then just try them... start with Rockwell, then 
Practical Peripherals, then Microcom and lastly US Robotics. Select one of the following:

· Generic Rockwell for modems that use &K commands to select flow control and \N to select auto-
reliable error control mode. Merely having a Rockwell chip is not a reason for using a Rockwell driver 
file.

· Generic Practical Peripherals if your modem uses &K commands to select flow control and &Q to 
select auto-reliable error control mode.

· Generic Microcom if your modem uses \Q commands to select flow control and \N3 to select auto-
reliable error control mode....BUT look in your modem manual for a "UK compliance information" 
section: if it says the modem is supplied by the GVC Corporation, then select Generic GVC instead. 
In this case it will be using \N6 to select auto-reliable error control mode.

· Generic US Robotics if your modem uses &H and &R commands to select flow control and uses &K 
to select auto-reliable error control mode.

If none of the options above appear to be suitable, try the general AT&F or ATZ entries. The former 
assumes that the manufacturer has set up the modem sensibly, the latter that you have managed to do 
so, and got it roughly right!

Please write to modems@turnpike.com for help. If your modem is not recognised, we may ask to borrow 
the modem manual for a few days. We will then endeavour to add your modem to the Turnpike list for the 
benefit of other users.

If you need further help, click here for details of the number to ring.

Related Topics
Com Ports



Window menu

Cascade
Logging

The following functions are not applicable to Turnpike connect. They are therefore greyed out.

Tile
Arrange icons



      
Window menu: Cascade
Opens Turnpike windows in a cascade i.e    
one on top of the other, starting from the top
left-hand corner of the main Turnpike 
screen area.



      
Window menu: Session review (Telnet only)
Switches into the 'Session view' of a Telnet session in which 
you can scroll through the different commands and responses 
that have been given throughout the session.

This option should only be selected in 'quiet' periods when you 
aren't expecting data from the remote computer. The display 
needs to be switched back into the standard 'Terminal screen' 
view when such information arrives.

Quick keystroke: F9



      
Window menu: Terminal screen (Telnet only)
Switches back to the standard Terminal display within a 
Telnet session. Quick keystroke: F9.



Status Colours dialog

This dialog is is displayed by choosing Colour option from the Option menu

The dialog shows the colours set for the main areas of the main connect window.

· To set or change a colour
Click the Alter button to display the Colour selection - status colours dialog.

Related Topics
Options menu



      
Windows logging
Select this option from the Window menu, 
to display the log file.

Alternatively click the Log Window button 
on the main Connect display.

For further details see Logging.



Windows NT4

Turnpike works fine under Windows NT4 but you will need to use NT4's RAS.

· Use Windows NT4's Remote Access Service (RAS).

1. From the Windows NT Start menu, select the Control Panel.
2. Select Networks 'Add software' and install the RAS software and the TCP/IP protocol on your 

machine.
3. Ensure that the RAS is configured to have TCP/IP as a dial-out protocol.
4. Select the TCP/IP protocol Configure option.

5. Select DNS and set your host, domain and the DNS servers you will be using.

· If you are about to sign up for a Trial account with Demon, you need to give olr as the Host, 
demon.co.uk as the Domain, and 158.152.1.58 and 158.152.1.43 as the DNS Servers. 

· In other cases, you can find out the addresses that you required by running the Turnpike Connect 
program and selecting the Service access option from the Configure menu.

6. Save the appropriate dial-up script for the service you intend to use.

If you are signing up for a Trial account with Demon, you will need to edit this file after you've signed up to
record the hostname and password you set up for your Trial account.

· Set up the Edit Phonebook dialog.

On the 'Basic' page:
1. Set a name for the service you will be dialling e.g. Demon Internet;
2. If you are about to sign up for a Demon Trial account, enter the phone number you will be 

dialling 0845 353 5666;
3. Select the modem you will be using from the list of modems installed on your machine;
4. To contact Demon, check that this modem is configured to enable hardware flow control, plus 

modem error control and modem compression (if your modem supports these).

On the Server page
Select PPP as your dial-up server type and TCP/IP (suitably configured for your Access Provider) 
as the network protocol.
For contacting Demon, configure the TCP/IP to take a server-assigned IP address.

· If you're about to sign up for a Trial account, set 158.152.1.58 and 158.152.1.43 as the DNS 
Servers and use VJ Header Compression and the Default gateway on the remote network. 

· If you use Demon, select the Enable PPP LCP extensions option.

On the Script page
1. Click Refresh list (to make your new script available).
2. Select your script to run, from the list of scripts offered.

On the Security page 
Select the option to Accept any authentication, including clear text and click the Unsave 
password option (if offered).

 Once set up you will be able to edit details from Turnpike Connect.



Related Topics
NT4 dial-up script
Service Acess



      
Windows error
Consult your Windows 
documentation.



Winsock error - no buffer space
Under some circumstances, the Winsock will report that it has run out
of buffer space. This doesn't cause you to lose any email or news, but
it can be inconvenient.
If you find this happens, edit the NTSX.INI file in \windows and 
change the SendLimit= setting in the [WINSOCK] section to 2048 
(usually 8192). This will limit resource usage and avoid the error.



Winsock
The Winsock you use is the ultimate interface through
which Turnpike and Internet applications you run 
alongside Turnpike, send and receive information 
across the Internet. Refer also to Running other 
Winsock applications.



      
Workgroups
A workgroup is a group of users on a multi-user system in which any one can reply to, 
file etc. mail that arrives for this workgroup. Workgroups are particularly useful within a 
company where you might setup workgroups to handle such things as Sales enquiries 
or Customer Support enquiries.

When a piece of mail arrives for a workgroup, it appears in the In-tray of every member 
of the group but the moment any member reads it, it then becomes theirs to deal with 
and disappears from other members' In-trays.

Workgroups are setup from the main Turnpike program. For further information 
either call up the on-screen Help within that program and search for information on 
Workgroups or read the section on Organising users into workgroups in the Set-Up 
book.



Paths
If the mail and/or news files have been moved to a new 
location or you want to find out where these are stored, click 
the Paths button on the Sign-on dialog. If you have 
permission you will then be able to set new paths for these files
in the dialog that's displayed. For further details refer to Setting 
where mail and news is stored.



Alert: Trial Account Setup - Account Name

As stated you must enter an account name before you can proceed further.
If you require further help, click the Help button on the dialog.
Click the OK button to continue.



Alert: Trial Account Setup Account No.
You must enter an account number before you can proceed further.
If you require further help, click the Help button on the dialog.
Click the OK button to continue.



Alert: Trial Account Setup Sort Code
Check the sort code you have entered.
If you require further help, click the Help button on the dialog.
Click the OK button to continue.



Alert:Trial Account Setup    Bank Name.
You must enter the bank name before you can proceed further.
If you require further help click the Help button on the dialog
Click the OK button to continue



Alert: Trial Account Setup - Bank Branch
You must enter the bank branch before you can proceed further.
If you require further help, click the Help button on the dialog.
Click the OK button to continue.



Alert: Trial Account Setup - Bank Address
You must enter the bank address before you can proceed further.
If you require further help, click the Help button on the dialog.
Click the OK button to continue.



Alert: Trial Account Setup - Conditions of Use

You must check the box to accept the Conditions of Use, before you can proceed further.
If you require further help, click the Help button on the dialog.
Click the OK button to continue.



Alert: Trial Account Setup    Details Correct

You must check the box to confirm that the bank account details are correct, before you can proceed 
further.

If you require further help, click the Help button on the dialog.

Click the OK button to continue.



Alert: Trial Account Setup - Select Host

You must select a Hostname before you can proceed further.

If you require further help, click the Advice or Help buttons on the dialog.

Click the OK button to continue.



Demon Trial Account Setup - Introduction

You may wish to read all the Help pages that follow to see what questions you will be asked.

Ensure that your modem is installed and switched ON.

If after reading the associated help text, you do not understand any of the questions asked, contact 
Demon Internet on    0845 272-2444



Call costs: Tariff File Calculations

Usually the basic cost of a call is calculated by: 
· partitioning the call into sections each of which falls in a single time band
· multiplying the duration of each section by the tariff for the appropriate band 
· and then summing the costs for all sections. 

The cost of the call is then adjusted according to minimum and connection charges.

Sometimes this will be inadequate to express a pricing scheme. For instance when the minimum charge 
is expressed as a minimum call length. In order to handle unusual pricing schemes an arithmetic 
expression, called a cost function, can be specified for calculating the cost of part of a call.

A cost function can be any arithmetic expression using
unsigned integer numbers,
the operators +, -, *, /,
the tokens s, e and t, 

where s = seconds elapsed since start of call of start of section to cost, 
e = seconds elapsed since start of call of end of section to cost, 
t = tariff for this band in pence per second,

the functions max(x,y) and min(x,y),
the functions floor(x) and ceil(x),
and brackets (, ). 

The order of precendence is the usual one:
1.      (,) 
2.      *, /
3.      +, -

A cost function can be specified for individual bands by adding the expression to the end of the Band 
entry.
Band=0;150;t * (((1 - min(1, s)) * 30) + (max(e, 30) - max(s, 30)))

or once for all bands in the [Data] section in a separate entry
CostFunction=t * (((1 - min(1, s)) * 30) + (max(e, 30) - max(s, 30)))

If no cost function is specified for a band then the cost function specified in the CostFunction entry will be 
used. If there is no CostFunction entry then the default function t*(e-s) will be used.

The function is applied once for each section a of a call which falls in a single time band. Hence t * 
max(e - s, 30) does not enforce a minimum call length of 30 seconds. If a call spans two time bands it 
will be applied twice, once to calculate the cost of the section of the call falling in one time band and 
once to calculate the cost of the section of the call falling in the other time band, giving a minimum 
total call length of 60 seconds for that particular call. To enforce a minimum total call length of 30 
seconds the cost function should be t * (((1 - min(1, s)) * 30) + (max(e, 30) - max(s, 30))).

The grammar for a cost function expression:

expression = [term] | [[expression], ["+" | "-"], [term]]



term = [atom] | [[term], ["*" | "/"], [atom]]
atom = [variable] | [digit-string] | [function] | ["(", [expression], ")"]

variable = "s" | "e" | "t" 
digitString = <non-negative decimal integer>    
function = unary-function | binary-function

unary-function = ["floor" | "ceil"], "(", [expression], ")"
binary-function = ["max" | "min"], "(", [expression], ",", [expression], ")"

Related Topics 
Typical tariff file.
Call costs: Tariff File format
Call costs



Demon Internet Modem and ISDN Access Numbers

The COLT ROMP (0845 353 5666/7) and the Cable and Wireless ROMP (0845 301 1666/7), 
previously used to dial up Demon Internet, have now been discontinued. 

Users previously using either of the above ROMPs should now be using the Green ROMP.

If you are using a modem the number is 0845 212 0666

If you are using ISDN the new number is 0845 212 0667

For further details and other ROMPS available refer to Demon Internet web page http\\
www.demon.net/connect/pop/pops.html.

Related Topics
Installing a new Access Provider 




